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Safety Information
Important Information

NOTICE Read these instructions carefully, and look at the equipment to become familiar with 
the device before trying to install, operate, or maintain it. The following special 
messages may appear throughout this documentation or on the equipment to warn 
of potential hazards or to call attention to information that clarifies or simplifies a 
procedure.

The addition of this symbol to a Danger or Warning safety label indicates
that an electrical hazard exists, which will result in personal injury if the
instructions are not followed.

This is the safety alert symbol. It is used to alert you to potential personal
injury hazards. Obey all safety messages that follow this symbol to avoid
possible injury or death.

DANGER indicates an imminently hazardous situation, which, if not avoided, will 
result in death or serious injury.

DANGER

WARNING indicates a potentially hazardous situation, which, if not avoided, can result 
in death, serious injury, or equipment damage.

WARNING

CAUTION indicates a potentially hazardous situation, which, if not avoided, can result 
in injury or equipment damage.

CAUTION
35013563 01 November 2007 9



Safety Information
PLEASE NOTE Electrical equipment should be installed, operated, serviced, and maintained only by 
qualified personnel. No responsibility is assumed by Schneider Electric for any 
consequences arising out of the use of this material.

© 2007 Schneider Electric. All Rights Reserved.
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About the Book
At a Glance

Document Scope This manual presents, using a documented example, how to use motion function 
blocks (MFB) with Modicon M340 using Unity Pro. These blocks enable simplified 
management of servodrives and servo-amplifiers using the CANopen bus.

Expert knowledge of Unity Pro software is required in order to use MFBs with it, 
since their implementation requires use of its standard functions (data editor, 
IODDT, etc.).

Moreover, it is advisable to have expert knowledge of the specialist area of motion 
control before developing and commissioning an application involving implemen-
tation of axis movements.

Validity Note The data and illustrations found in this documentation are not contractually binding. 
We reserve the right to modify our products in line with our policy of continuous 
product development. 

The information in this document is subject to change without notice and should not 
be construed as a commitment by Schneider Electric.

Product Related 
Warnings

Schneider Electric assumes no responsibility for any errors that may appear in this 
document. If you have any suggestions for improvements or amendments or have 
found errors in this publication, please notify us.

No part of this document may be reproduced in any form or by any means, electronic 
or mechanical, including photocopying, without the express written permission of 
Schneider Electric.

All pertinent state, regional, and local safety regulations must be observed when 
installing and using this product.

For reasons of safety and to ensure compliance with documented system data, only 
the manufacturer should perform repairs to components.

When controllers are used for applications with technical safety requirements, 
please follow the relevant instructions.
35013563 01 November 2007 11



About the Book
Failure to observe this product related warning can result in injury or equipment 
damage.

User Comments We welcome your comments about this document. You can reach us by e-mail at 
techpub@schneider-electric.com
12 35013563 01 November 2007
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I

Start-up Guide for a Single Axis 
Application
At a Glance

Subject of this 
Section

This section presents, in the form of a tutorial, an example of a motion control 
application implementing MFBs using Unity Pro.

What's in this 
Part?

This part contains the following chapters:

Chapter Chapter Name Page

1 Foreword 15

2 Application Configuration 19

3 Application Programming 57

4 Application Debugging 75

5 Operating the Application 83

6 Application Maintenance 87
13



Single Axis Application
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Foreword
At a Glance

Subject of this 
Chapter

This chapter presents the specifications of the application as well as the 
methodology used in its development.

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

General 16

Methodology 17
15



Foreword
General

Introduction The MFB using Unity Pro offer is a new motion control functionality. Using the 
CANopen bus, it provides you with simplified access to the basic functions on 
servodrives and servo-amplifiers.

This functionality, which may be accessed via the project browser, allows you to:
declare and configure axes in Unity Pro,
create motion control variables,
control the axes by using motion control elementary function blocks.

Specifications The purpose of the proposed application is to:
manage the operating modes of a linear axis using a Lexium 05-type servodrive,
move the axis to the home position, carry out reversing movements or move the 
axis to various positions,
provide the possibility of interrupting the motion in progress with a Stop 
command.

All provisions shall be taken to perform fault diagnostics and acknowledgement.

Standards The MFB library blocks comply with:

PLCopen standard
IEC-61131-3 standard
16 35013563 01 November 2007



Foreword
Methodology

Overview The flowchart below lists the various stages involved in installing the application: 

Configuration of the hardware using 
Unity Pro

Declaration and configuration of the 
CANopen bus using Unity Pro

Configuration of the axes via MFB
using Unity Pro

Programming the application using 
the MFB library

Hardware configuration of the 
servodrives

1

4

2

3

5

Debugging6

Operation7

Maintenance8
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Foreword
The table below details the tasks to be performed for each stage of the flowchart.

Step Description

1 In Unity Pro:
create the project and select the processor.

2 In Unity Pro:
open a CANopen bus configuration,
choose the CANopen slave in hardware catalog,
attribute a topological address to the new device,
check or set MFB function in the configuration window of device,
enable CANopen configuration,
check the accuracy of the configuration using the CANopen configuration 
tree structure in the project browser.

3 Create the axes in the project browser’s Motion directory.
Define the variables associated with these axes during their creation.

4 With the PowerSuite software:
connect to the device,
enter the required parameters for the correct operation of the CANopen 
communication (address, speed, etc.).

5 Program the motion sequences using the appropriate functions blocks from the 
MFB library.
Associate the variables defined during creation of the axis with the MFB blocks.

6 Debug the axis using PowerSuite.
In Unity:

debug the program via the animation table,
use the data via the operator screens.

7 manage the production recipes using the appropriate function blocks from the 
MFB library:

create and back up the recipes,
transfer data from the recipes.

8 Data backup and restore procedures.
18 35013563 01 November 2007
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Application Configuration
At a Glance

Subject of this 
Chapter

This chapter describes the various stages involved in configuring the application.

What's in this 
Chapter?

This chapter contains the following sections:

Section Topic Page

2.1 Hardware and Software Environments 21

2.2 Configuration of the Application using Unity Pro 25

2.3 CANopen Bus Configuration 29

2.4 Axis Configuration using the Motion Tree Manager 37

2.5 Configuring the Lexium 05 49
19



Application Configuration
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Application Configuration
2.1 Hardware and Software Environments

At a Glance

Subject of this 
Section

This sub-section describes the hardware and software environments used in the 
application.

What's in this 
Section?

This section contains the following topics:

Topic Page

Application Architecture with a Lexium 05 22

Software Requirements 23

Hardware Requirements 24
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Application Configuration
Application Architecture with a Lexium 05

Overview The proposed architecture is simple and designed to assimilate the implementation 
principles of motion control.

Other equipment can be added to this realistic architecture in order to manage 
several axes.

Illustration The following figure shows the architecture used in the application that includes a 
Lexium 05. 

LEXIUM  05

Unity 
Pro

PowerSuite 

CANopen

Junction box

Modicon M340
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Application Configuration
Software Requirements

Overview To implement the example, it is essential to have certain items of software on single 
PC. In particular, this will allow you to configure, set parameters for and operate the 
various devices used.

The software architecture is composed of:

Unity Pro, which is used to control the servodrive via the CANopen bus by 
programming movements 
Powersuite, which is used to set parameters and adjust the Lexium 05 servodrive

It is nonetheless possible to go without PowerSuite in certain cases by using the 
Lexium 05 front panel user interface (see Configuring the Lexium 05 with the User 
Interface, p. 54).

Versions The following table lists the hardware and software versions used in the architecture 
(see Application Architecture with a Lexium 05, p. 22), enabling the use of MFBs in 
Unity Pro.

Hardware Earliest version of software Earliest version of 
firmware

Modicon M340 Unity Pro V3.0 -

Lexium 05 PowerSuite for Lexium 05 V2.2.0, 
patch V2.2.0B

V1.120
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Hardware Requirements

References of 
the Hardware 
Used

The following table lists the hardware used in the architecture (see Application 
Architecture with a Lexium 05, p. 22), enabling implementation of Lexium 05 MFBs 
in Unity Pro.

Hardware Brand Reference

Modicon M340 PLC Telemecanique BMX P34 2030

Modicon M340 power supply Telemecanique BMX CPS 2000

Modicon M340 rack Telemecanique BMX XBP 0800

CANopen junction box between the  
Modicon M340 and Lexium 05 
servodrive

Telemecanique VW3CANTAP2

RJ45 programming cable with RS485/
RS232 adapter between the junction 
box and servodrive

Telemecanique ACC2CRAAEF030

Lexium 05 servodrive - LXM05AD10M2

Lexium 05 motor Telemecanique BSH0551T

Note: The terminating resistor is integrated in the Lexium 05.
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2.2 Configuration of the Application using Unity Pro

At a Glance

Subject of this 
Section

This sub-section describes the hardware configuration using Unity Pro.

What's in this 
Section?

This section contains the following topics:

Topic Page

Creating the Project 26

Master Task Configuration 27
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Creating the Project

At a Glance Developing an application using Unity Pro involves creating a project associated 
with a PLC.

Procedure for 
Creating a 
Project

The table below shows the procedure for creating the project using Unity Pro.

Note: For more information, see Unity Pro online help (click on  and in the 
Contents tab, select Unity → Unity Pro → Operating modes → Project 
configuration).

Step Action

1 Launch the Unity Pro software,

2 Click on File then New then select the BMX P34 2030 PLC,

3 Confirm by clicking OK. The application inserts a rack and a power supply by default.

PLC Description
M340

BMX P34 1000
BMX P34 2010
BMX P34 2020
BMX P34 2030

New Project

OK

Cancel

Help

Micro Basic

CPU 340-10 Modbus CANopen

Version

CPU 340-10 Modbus Ethernet
CPU 340-10 Ethernet CANopen

01.00
01.00
01.00
01.00

CPU 340-10 Modbus

Premium Premium
Quantum Quantum

Show all versions
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Master Task Configuration

General The first operation you need to perform to create a program is to select the type of 
Tasks.

You are advised to program the servodrive movements using MFB blocks in the 
MAST task. This task must be scanned at regular intervals.

MFB blocks unexpected behavior 

CAUTION

Do not mixe MAST and FAST tasks. It is possible to use the FAST task to program 
the MFBs.
Failure to follow these instructions can result in injury or equipment damage.
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Configuration The following table describes the procedure for setting the parameters of the MAST 
task:

Step Action

1 In the Project Browser, expand the Program directory.
The MAST directory is displayed.

2 Right-click on the MAST directory and then execute the Properties command in the contextual 
menu.

3 Click on Properties and the following dialog box appears:

4 Select the Periodic type of scanning.

5 Set the task period to 20 (due to the specific INPT parameter of the servodrive).

6 Set the Watchdog value, which must be greater than the period value.

7 Click on OK to confirm the configuration.

MAST Properties

OK Cancel Help

General Comment
Name:  Configuration

Periodic
Cyclic

20

250

Period:

Watch Dog:

MAST

Apply

(ms):

(ms):
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2.3 CANopen Bus Configuration

At a Glance

Subject of this 
Section

This section presents the CANopen bus configuration methodology.

What's in this 
Section?

This section contains the following topics:

Topic Page

Implementation Methodology for a CANopen Bus 30

Configuration of the CANopen port 31

Configuration of the CANopen Slave 33

Checking the CANopen Bus Configuration 36
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Implementation Methodology for a CANopen Bus

Overview The following flowchart shows the implementation methodology for a CANopen bus 
using Modicon M340. 

Configuration of the CANopen port of 
the CPU( the master)

Configuration of the slave

Enabling the configuration 
using Unity Pro

Using Unity Pro 

Declaration of the slave choosen
in the Hardware catalog

Checking the CANopen bus
 in the Project Browser
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Configuration of the CANopen port

At a Glance With Unity Pro you can define the CANopen bus.

The CANopen bus master is a port integrated in the CPU.

First, the bus master must be configured.
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How to Configure 
the CANopen 
Bus Master

This table describes the procedure to configure the CANopen port using Unity Pro.

Step Action

1 In the Unity Pro Project Browser, fully expand the Configuration directory and then double-click on PLC 
bus.

2 Double-click on CANopen port of PLC.
Result: The port configuration window appears: 

3 In the Bus parameters area, set 500 kBaud for the transmission speed.
In the Task area, select MAST.
In the Outputs area select Reset radio-button. (Strongly recommended)  

4 Validate the configuration.

5 Note: We recommend using the IODDT T_COM_CO_BMX that corresponds to the CANopen port for the 
rest of the programming. Enter CAN for the prefix name.
Close the window.

0.0: CANopen : CANopen comm head

Communicator head CANopen

CANopen comm head

Channel 2

Task:
MAST

Function:

Config
 Inputs  Outputs

Bus parameters

CANopen

Transmission speed
SYNC Message COB-ID
SYNC Message period

kBaud
128

No. of words (%MW) 32
Index of first %MW 0

No. of bits (%M) 32
Index of first %M 0

No. of words (%MW) 32
Index of first %MW 0

No. of bits (%M) 32
Index of first %M 0

500

ms100

 RESETMaintain
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Configuration of the CANopen Slave

How to Configure 
the CANopen 
Slave

This table describes the procedure to configure the CANopen slave.

Step Action

1 In the Unity Pro Project Browser, fully expand the Configuration directory and then double-click on 
CANopen.
Result: The CANopen window appears: 

CANopen

Bus: CANopen comm head 01.003 Connections configured: 0
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2 Select Edit → New device.
Result: The New Device window appears: 

3 Set 2 in Topological Address.
Choose Lexium05_MFB for the slave device.

Step Action

Part Number Description
CANopen drop

ATV31_V1_1
ATV31_V1_2
ATV31T_V1_3
ATV61_V1_1

New Device

OK

Cancel

HelpDiscrete
Motion

Topological Adress:        [1..63] 

Altivar 31 CANopen Slave DSP402 (TEATV3111E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV31T13E.eds)
ATV61 (TEATV6111E.eds)

ATV71_V1_1 ATV71 (TEATV7111E.eds)
IclA_IFA IclA-IFA CANopen (IclA-IFA.eds)
IclA_IFE IclA-IFE CANopen (IclA-IFE.eds)
IclA_IFS IclA-IFS CANopen (IclA-IFS.eds)

Lexium15LP_V1_4 EDS for Lexium 15LP servodrive (TELXM15LP_0142.eds) 
Lexium15MH_V6_61 EDS for Lexium 15MPHP servodrive (TELXM15MH_0661E.eds)
Osicoder Osicoder - absolute rotary multi-turn encoders (TEXCC3B_0100E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV3112E.eds)

Node-ID:
2
2

IclA_N065 IclAN065 based on profiles DS301V4.01 and DSP402.V2.0 (BLIC....
Lexium05 DCX170 CANopen (TEDCX107_0100E.eds)
Lexium05_MFB LXM05A PLCopen (LEXIUM05_MFB.EDS)

Other

Drop end communicator
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4 Click on OK to confirm the choice.
Result: The CANopen window appears with the new device selected: 

5 Select Edit → Open module.
If MFB has not already been selected, choose it in the Function area.

6 Select the tab Error Control.
Verify that Node Heartbeat Producer time value is equal to 300ms.

7 You will be asked to validate your modifications when closing the Device and CANopen windows.

Step Action

CANopen

Bus: CANopen comm head 01.003 Connections configured: 1

2 0

...
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Checking the CANopen Bus Configuration

At a Glance The CANopen bus is represented in the Configuration directory of the project 
browser. 

After having selected and enabled the CANopen configuration, the CANopen slaves 
appear in the Project Browser. 

The topological address of the CANopen bus is calculated automatically by 
Unity Pro. This value cannot be modified.

The diagram below shows the CANopen bus with slave device from the tutorial 
example: 

Structural View
Project Browser

Station

0: BMX XBP 0800
(P)(P): BMX CPS 2000
0: BMX P34 2030

Configuration
0: PLC bus

1

3: CANopen
2: CANopen drop

0:0 LXM15MH_V6_61

Variables & FB Instances
Motion

Derived FB Types
Derived Data Types

Topological address of 
the CANopen bus 
(cannot be modified).

Slave address.

CANopen

Device name.

Ethernet

2
3
4
5
6
7
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2.4 Axis Configuration using the Motion Tree 
Manager

At a Glance

Subject of this 
Section

This sub-section describes the Motion directory added to Unity Pro’s project 
browser. It also presents a procedure for creating the axis in this directory.

What's in this 
Section?

This section contains the following topics:

Topic Page

Motion Directory 38

Axis Creation and Configuration 40

The Variables Axis_Ref, Can_Handler, AxisParamDesc and Recipe 45

Motion Directory Configuration Result 47
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Motion Directory

At a Glance The Motion directory of the structural view of the project allows you to access the 
declaration and configuration of the servodrives.

This service is available on Premium (See Motion Function Block: Start-up Guide for 
a Single Axis Application) and Modicon M340 (see Start-up Guide for a Single Axis 
Application, p. 13) platforms.

When declaring a servodrive, various information is required, such as: 

the name given to the servodrive
the type of servodrive
the CANopen address of the servodrive
the reference of the servodrive
the version of the servodrive
the input of variable names associated to the axis.

The following diagram shows an example of a tree structure for the Motion 
directory: 

In this diagram, the name given to the servodrive is ‘Axis_Z’. 

A recipe is linked, by default, each time an axis is created. It is possible to create 
several recipes (see Backup and Transfer of the Servodrive Parameters, p. 71).

Structural View

Project Browser

Station
Configuration

Derived Data Types
Derived FB Types
Variables & FB Instances
Motion

Axis_Z
Recipe1
Recipe2

Communication
Program
Animation Table

Operator Screens
Documentation

Motion Tree Manager
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Accessible 
Services

The Motion directory gives you access to the following services, which can be 
reached via the contextual menu:

Directory Service

Motion New axis: allows you to create a new axis.

Axis New recipe: allows you to create a new recipe.
Delete: allows you to delete an axis.
Properties: allows you to access the axis properties.

Recipe Delete: allows you to delete a recipe.
Properties: allows you to access the recipe properties.
35013563 01 November 2007 39



Application Configuration
Axis Creation and Configuration

General The Motion directory is used to declare an axis. 

This creation allows you to simplify the management and programming of an axis 
using Unity Pro.

Note: For any modification to a device on the CANopen bus, those servodrives 
unaffected by the modification do not need to be reconfigured.
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Creating an Axis Carry out the following actions:

Step Action

1 Right-click on the Motion directory and then execute the New axis command in the 
contextual menu.

2 Clicking on the New axis command will open a dialog box with three tabs.

3 In the General tab,
enter:

a name
select:

a servodrive from the list
a compatible CANopen address

Note: If the CANopen addresses have not as yet been defined, leave <No link> in 
the list. It is possible to continue development of the application if <No link> is 
assigned to a compatible CANopen address.
When the CANopen addresses have been defined, select the compatible address 
in the list.
In this tab, the Axis_Z is configured as follows: 

HelpCancelOK

General Axis parameters

Axis_Z
Name:

Lexium 05
List of available Drive:

CANOpen
Network type:

List of compatible address:

Variables name

\3.2\0.0

Project Browser

Structurial view

Configuration
Derived Data Types
Derived FB Types
Variables & FB instances

Communication
Program
Animation Tables
Operator Screens
Documentation

Station

Motion
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4 In the Axis Parameters tab, select:
the reference of the servodrive
the minimum version of the servodrive’s firmware

In this tab, the Axis_Z is configured as follows: 

Note: You are advised to check for consistency between the version of the 
servodrive’s firmware and the version declared in Unity Pro. The version is used to 
define the drive parameters. During the servodrive init by the CAN_HANDLER MFB 
function block, the vesrsion is tested.

Step Action

HelpCancelOK

General Axis parameters

LXM05AD10???
Part Num:

Software version:

Variables name

1.0

Project Browser

Structurial view

Configuration
Derived Data Types
Derived FB Types
Variables & FB instances

Communication
Program
Animation Tables
Operator Screens
Documentation

Station

Motion
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5 In the Variables Name  tab, enter:
a name for the Axis_Ref type variable linked to the servodrive
a name for the Can_Handler type variable linked to the servodrive

In this tab, the Axis_Z is configured as follows: 

6 Click on OK to confirm the selections.

7 Right-click on the Recipe_0 sub-directory and then select Properties in the 
contextual menu. It is then possible to modify the recipe and parameter variables 
created by default when creating the axis.
In this window, the variables for the Axis_Z are named by default as follows: 

Step Action

HelpCancelOK

General Axis parameters

Axis_Ref_Z
Axis reference variable name:

CANopen handler variable name:

Variables name

Can_Handler_Z

Project Browser

Structurial view

Configuration
Derived Data Types
Derived FB Types
Variables & FB instances

Communication
Program
Animation Tables
Operator Screens
Documentation

Station

Motion

HelpCancelOK

Recipe_0
Recipe variable name:

AxisParamDesc_0
Parameter description variable name:

Variables name

Project Browser

Structurial view

Configuration
Derived Data Types
Derived FB Types
Variables & FB instances

Communication
Program
Animation Tables
Operator Screens
Documentation

Motion

Station

Axis_Z
Recipe_0
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8 Click on OK to confirm the configuration.

Step Action

Note: It is possible to create several recipes for the same axis (there is one by 
default). Loading of the required recipe, depending on the request, is performed by 
the TE_DOWNLOADDRIVEPARAMETER (See Motion Function Block: 
TE_DownloadDriveParam) block.
This MFB library block is used to:

load parameters to a new servodrive if the previous one is faulty.
load a new recipe to a servodrive during a production change, for example

You can delete the recipe if you can not use it.

Note: The memory size of unlocated data for the management of a recipe by 
servodrive type is around 2 Kwords.
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The Variables Axis_Ref, Can_Handler, AxisParamDesc and Recipe

At a Glance For each axis creation, four variables are created:

A Can_Handler-type variable which can be renamed using the axis directory
An Axis_Ref-type variable which can be renamed using the axis directory

A byte table type variable (ARRAY[....] OF BYTE) named by default Recipe_x 
(where x  is a value) but which can be renamed using the Recipe_x directory
An unsigned integer table type variable (ARRAY[....] OF UINT) named 
AxisParamDesc_x (where x is a value) and which may not be renamed

Can_Handler This variable is an EFB type variable. It is named after the CANopen manager 
variable.

It is declared in the Variables Name tab during Axis Creation (see Axis Creation and 
Configuration, p. 40).

It must be used in the program as the instance of the CAN_HANDLER (see The 
CAN_HANDLER Function Block, p. 61) MFB function block.

Axis_Ref This variable is an AXIS_REF-type structured variable named after the axis 
reference variable.

It is declared in the Variables Name tab during Axis Creation (see Axis Creation and 
Configuration, p. 40).

It must be specified in the input parameter for each MFB block used by the axis.

AxisParamDesc This variable is an unsigned integer table type variable (ARRAY[....] OF UNIT). It is 
automatically created during Axis Creation (see Axis Creation and Configuration, 
p. 40). It is named after the parameter description variable which can be seen in the 
Recipe_x properties of the axis.

This variable must be specified in the TE_UPLOADDRIVEPARAMETER (See 
Motion Function Block: TE_UploadDriveParam) and 
TE_DOWNLOADDRIVEPARAMETER (See Motion Function Block: 
TE_DownloadDriveParam) blocks’ PARAMETERLIST input parameter taken from 
the MFB library and useful for recipe creation or for replacing the axis if it is faulty.

This variable:
cannot be modified,
is identical if the axes declared in the application have the same references and 
firmware version.
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Recipe This variable is a byte table type variable (ARRAY[....] OF BYTE). It is automatically 
created during Axis Creation (see Axis Creation and Configuration, p. 40). It is 
named after the recipe variable which can be seen in the Recipe_x properties of 
the axis.

This variable must be specified in the TE_UPLOADDRIVEPARAMETER (See 
Motion Function Block: TE_UploadDriveParam) or 
TE_DOWNLOADDRIVEPARAMETER (See Motion Function Block: 
TE_DownloadDriveParam) block’s PARAMETERSET input parameter taken from the 
MFB library and useful for recipe creation or for replacing the axis if it is faulty.

The variable name may be modified using the Recipe_x properties of the axis.
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Motion Directory Configuration Result

In the Project 
Browser

The following diagram shows the tree structure for the Motion directory after 
configuration: 

Structural View

Project Browser

Station
Configuration

Derived Data Types
Derived FB Types
Variables & FB Instances
Motion

Axis_Z
Recipe_0

Communication
Program
Animation Table

Operator Screens
Documentation
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In the Data Editor The following screen shows the variables that are created in the data editor during 
the creation of the axes. To access this screen, double-click on the Variables & FB 
instances directory in the project browser: 

The variable Can_Handler_Z may be accessed by clicking on the Function 
blocks tab.

Variables

EDTName

DDT types Function blocks DFB types

Filter
DDT IODDT*

Data Editor

Name Type Addre... CommentValue
ARRAY[0..190] OF BYTERecipe_0

ARRAY[0..218] OF UINTAxisParamDesc_0 Type: 306, Ref: 12592, Ver: 1.03
AXIS_REFAxis_Ref_Z Variable declared for axis: Axis_Z
48 35013563 01 November 2007



Application Configuration
2.5 Configuring the Lexium 05

At a Glance

Aim of this 
Section

This section describes the basic servodrive configurations using PowerSuite for 
Lexium 05 and the servodrive’s front panel user interface.

What's in this 
Section?

This section contains the following topics:

Topic Page

Configuring the Lexium 05 in PowerSuite 50

Configuring the Lexium 05 with the User Interface 54
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Configuring the Lexium 05 in PowerSuite

Overview With PowerSuite, users can define installed device bases, and describe their 
associated configurations and communication settings.

PowerSuite then gives access to a group of actions for editing or transferring the 
configurations and for connecting to the devices.

PowerSuite’s navigation principle associates a configuration interface with each 
device type, making it possible to control, tune and monitor them.

Note: The required signals, i.e LIMN, LIMP, REF must be wired or deactived by  
the tuning software.
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Connecting to 
the Lexium 05

This table describes the procedure for connecting to the Lexium 05:

Step Action

1 Connect your PC, on which PowerSuite for Lexium 05 is installed, to the RJ45 connector on the servodrive 
to be configured.

2 Start PowerSuite for Lexium 05,
Result: the following start-up screen is displayed: 

3 Choose Action and then Connect.
Result: a text box is displayed.

4 Type a project name (Lexium05_MFB) and then click on OK.
Result: a transfer confirmation window is displayed.

5 Press Alt F to start transferring data from the servodrive to the connected work station.

File Action Display Tools Help

Connections
My devices

PowerSuite

My devices

i

standard en
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Basic Lexium 05 
Configuration

This table describes the procedure for entering basic settings:

Step Action

1 Following a connection and transfer of the device’s configurations, PowerSuite displays a configuration 
screen in a new window that gives access to device control, tuning and monitoring functions.
In the tree structure displayed, choose CANopen in the Communication directory.
Result: the following window is displayed: 

2 Double-click on the value in the ID_COAD line, Current Value column, and type the Lexium 05 CANopen 
address.

3 Double-click on the value in the ID_COBD line, Current Value column and choose the CANopen bus baud 
rate.

4 Save the CANopen settings to EEprom with the command Configuration → Save to EEprom.
Note: it is possible to adjust the servodrive’s settings with the same procedure.

Lexium05
   All parameters
      Simply start
         Basic configuration
         In speed control (+/-10V)
         In Current control (+/-10V)
         In Gear mode
         In position control
      Configuration
         ANA2 analogue input
         External braking resistor
         Holding brake
         Encoder simulation 
         HMI
         Reference and limit switches 
         Position scaling
         PWM
         Profile generator
         Supervision
      Settings
         ANA1 analogue input
         Regulation loop
         Limitations
         Stanstill
      Motion

File Parameters Command Display Configuration Tools ?
Find:

Standard profile en Connected

_p_refusr = 1066883 usr
_p_actusr = 1066883 usr
_n_ref    = 0       1/min
_n_act    = 0       1/min
_ldq_act = 0.03  Apk

Speed control mode
HALT =inactive
S.Fault= 0x0000
Local access
DEVcmdinterf=CANOpen

Command
Active
Inactive

CURref.
On
Off

Enable
On
Off

Min                 Max
-9.90   0.00      9.90

   CUR_I_target[A]

Test run

Test stop

PowerSuite - Lexium05 - LEXIUM_MFB

! Code
Code
ID_COAD
ID_COBD

Short label
CANadr
CANbaud

Long label
pen address (node
CANopen

Mini
1

50KB

Maxi
127

1MB

Current
3

500KB

Default 
127

125KB

Logical address
5892
5894

User
-
-

Reset

State
[4]Rdy Switch On
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5 Once the settings have been adjusted, use the command Configuration → Disconnect to disconnect.
Result: the following screen is displayed, showing the data saved locally: 

6 The Lexium 05 must be turned off and then turned back on in order to apply the new settings.

Step Action

PowerSuite
File Action Display Tools Help

i
My devices

LEXIUM_MFB
LEXIUM_MFB
Motor
Modbus keypad multidrop

My configurations
Connections

Serial monodrop
Serial multidrop
Bluetooth
Ethernet bridge monodrop
Ethernet bridge multidrop
Ethernet TCP

LEXIUM_MFB

Characteristics

Reference

Nominal
Power

Supply Voltage

Maximum
transient

current (peak)

Maximum
continuous
current (rms)

Interface

LXM05AD10M2

0,75kW

200/240 V1~

10 Apk

4 Arms

CANopen, Modbus
RTU,P/D,+/-10V 

Structure

Configuration(s)

Name

Software release

LEXIUM_MFB

P840.10V1.0|E03

Card

Device

Control
Board

Motor

BSH0551T
Family: BSH
Size: 9
Length: 7

LXM05AD10M2

Control part-
number

01510007438
P840.10
V1.0|E03 Telemecanique

Telemecanique

Telemecanique

Reference
Serial
number Version Vendor name
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Configuring the Lexium 05 with the User Interface

Overview A user interface is integrated in the Lexium 05. With this interface, you can:

put the device online
configure the device
carry out a diagnostic

Interface Menu 
Structure

The following graphic presents an overview of access to the interface’s main menus: 

First Setup

Settings

Drive Configuration

Autotuning

JOG Mode

Communication

Fault

Information/Identification

Status Information

ent

esc

ent

ent

ent

esc

esc

ent

ent

ent

ent

ent

ent

ent

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

Save

Power On:
- First Setup
   not done

- First Setup
  done

Menus
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Basic Settings The following table describes the procedure for entering basic settings (CANopen 
address and speed) with the interface.

Step Action

1 Press the ENT button on the interface.
Result: the SET (Setting) menu is displayed on the interface’s status indicator.

2
Press the  button several times to access the COM menu.

Result: the COM (Communication) menu is displayed on the interface’s status 
indicator.

3 Press the ENT button on the interface.
Result: the COAD (CANopen Address) submenu is displayed on the 
interface’s status indicator.

4 Press ENT again.
Result: a value corresponding to the device’s CANopen address is displayed.

5
Press the  button to decrease, or the  button to increase the 

CANopen address value.
Press ENT when the desired CANopen address is displayed (3).
Result: the value is confirmed and the COAD (CANopen Address) submenu 
is displayed again.

6 Press ESC once to return to the COAD submenu.

7
Press the  button to access the COBD (CANopen Baud) submenu.

Press ENT.
Result: a value corresponding to the device’s CANopen speed is displayed.

8
Press the  button to decrease, or the  button to increase the 

CANopen baud rate value.
Press ENT when the desired CANopen speed is displayed (500).
Result: the value is confirmed and the COBD (CANopen Baud) submenu is 
displayed again.

9 Press ESC several times to return to the main display (RDY by default).
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Application Programming
At a Glance

Subject of this 
Chapter

This chapter describes the various development phases of the application program.

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

Declaration of Variables 58

Programming the Example 59

The CAN_HANDLER Function Block 61

Management of the Axis’ Operating and Stop Modes 64

Motion Control 65

Motion Monitoring 68

Status and Axis Error Code Section 69

Backup and Transfer of the Servodrive Parameters 71

Transferring the Project between the Terminal and the PLC 72
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Declaration of Variables

At a Glance In addition to the variables associated with the axis when it is created in the Motion 
directory, other variables must be declared.

They must be assigned to:

Input or output parameters of the MFB blocs,
Operator Screen (see Representation, p. 82) objects.

They allow you to use certain data and to control the axis with blocks from the 
MotionFunctionBlock library.

Declaration in 
the Data Editor

The table below summarizes the variables to be created in the data editor for the 
tutorial example.

Name Type Comment

Cmd_Home_Z BOOL Return axis to home position command

Cmd_Mvt_Z BOOL Move axis command

Cmd_Run_Z BOOL Run axis command

Cmd_Stop_Z BOOL Stop axis command

Cmd_Reset_Z BOOL Acknowledge axis command

Cmd_Upload_Z BOOL Save axis data in a recipe table command

Cmd_Download_Z BOOL Transfer data from recipe table to axis command

Axis_OK_Z BOOL Axis recognized by CANopen bus

Position_Z DINT Value of axis position

Velocity_Z DINT Value of axis speed

Recipe_Z ARRAY[0..190] OF BYTE Buffer variable for management of recipes

Note: the size of the recipe management table complies with that of the recipes 
created by the Motion directory.
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Application Programming
Programming the Example

At a Glance Just after declaration and parameter setting of the hardware, motion programming 
is the second development phase of the tutorial example.

Axis programming is divided up into:

declaration of variables,
an operator screen which is used to view and control the axis,
structured programming in several sections.

Declaring the 
Sections

The table below presents a summary of the program sections to create

Section name Language Description

CAN_Handler (see 
The CAN_HANDLER 
Function Block, p. 61)

FBD This section allows you to check that the parameters 
of the axis correspond to reality.

Operating_mode (see 
Management of the 
Axis’ Operating and 
Stop Modes, p. 64)

FBD This section allows you to power up the servodrives 
and to check the axes.

Cmd_Mvt (see Motion 
Control, p. 65)

FBD This section allows you to set a homing reference 
point for the axis and to then control it in absolute 
motion.

Control_Mvt (see 
Motion Monitoring, 
p. 68)

FBD This section is used to determine the position and 
speed of the axis.

Status_Axes (see 
Status and Axis Error 
Code Section, p. 69)

FBD This section is used to determine the status of the axis 
and to carry out diagnostics for an event.

Recipe (see Backup 
and Transfer of the 
Servodrive 
Parameters, p. 71)

FBD This section allows you to save or restore a 
servodrive’s data.
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Application Programming
The diagram below shows the program structure after the programming sections 
have been created. 

Structural View

Program
Tasks

Sections
MAST

Operating_mode

SR Sections

I/O Events

TIMER Events
Events

CAN_Handler

Cmd_Mvt

Status_Axis
Recipe

FDB

FDB

FDB

FDB

FDB

Control_MvtFDB

Animation Tables

Screen
Operator Screens
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Application Programming
The CAN_HANDLER Function Block

At a Glance The use of the CAN_HANDLER (See Motion Function Block: TE_CAN_Handler) 
MFB function block is essential and mandatory in the programming of the axis. The 
program section with this MFB function block must be associated with the same task 
of the CANopen bus master (see How to Configure the CANopen Bus Master, 
p. 32). 

It allows you to check:

the CANopen communication,
consistency between the software configuration and the connected physical 
device.

This block uses the two variables that belong to the axis’ directory. The 
Can_Handler_Z variable must be used as instance and the Axis_Ref_Z variable 
must be assigned to the block’s AXIS input parameter.
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Application Programming
Inserting and 
Instantiating a 
Block

This table describes the procedure for inserting and select the instance of  a block 
in a program section.

Step Action

1 Right click in an empty field in the FDB section to display the contextual menu.

2 Execute the FFB Input Assistant.. command in the contextual menu.
Result: The Function Input Assistant opens.

3 Click on the ... icon on the FFB Type line.
Result: the FFB Type Selection window opens.

4 Expand Libraries → MotionFunctionBlock and click on MFB.
Result: all of the blocks from the MotionFunctionBlock library are displayed on 
the right-hand side of the FFB Type Selection window.

5 Select the CAN_HANDLER block and confirm your choice by clicking on OK.
Result: The FFB Input Assistant.. window is displayed, set up by the 
CAN_HANDLER block.

6 Click on the ... icon on the Instance line.
Result: the FB Instance Selection window opens.

7 Select the Can_Handler_Z instance and confirm your choice by clicking on 
OK.
Result: The Can_Handler_Z variable is displayed in the Instance field. 

8 Confirm the block configuration by clicking on OK.
Result: the FDB section is displayed again. A symbol is added to the mouse 
cursor.

Function Input Assistant

FFB type:

Name

Help

...

Can_Handler_ZInstance: ...

Prototype

Type No. Comment Entry field

CAN_HANDLER

Cancel

Help on TypeAdd Pin Remove Pin(s)

OKSpecial Assistant...

<Inputs>

AXIS_REF
BOOLNET...

AXIS
1 Specify if the netw...
2 Axis reference Trigger

<Outputs>

BOOL
BOOLAXIS...

ERR...
1 Indicate if the com...
2 Error code

<Inputs…
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Contents The screen below shows the section result: 

The input parameter NETWORKOPERATIONAL must be assigned to a bit that 
validates the correct operation of the CANopen network. 

The assignment of this parameter left to the discretion of the developer. It depends 
on the philosophy of the process and the way the bus is managed.

For example, this parameter may be connected to an object or to a 
T_COM_CO_BMX (See Modicon M340 using Unity Pro, CANopen field bus - User 
Manual, Details of T_COM_CO_BMX type implicit exchange objects of the IODDT)-
type IODDT equation.

9 Click on an empty field in the FDB section.
Result: the CAN_HANDLER block, instantiated by the Can_Handler_Z variable 
is inserted in the FDB section.

10 Specify the input and output parameters as defined in the contents.

Step Action

CAN_HANDLER

CAN_HANDLER_Z

1

Axis_Ref_Z

NETWORKOPERATIONAL

AXIS

AXISREADY

ERRORID

Axis_OK_Z

CAN.SLAVE_ACTIV_2 corresponds to the active slave bit 
 

CAN.SLAVE_ACTIV_2

created by the IODDT T_COM_CO_BMX. 
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Application Programming
Management of the Axis’ Operating and Stop Modes

At a Glance This section is made up of the following MFB blocks:

MC_POWER (See Motion Function Block: MC_Power), which is used to disable 
or enable the servodrives,
MC_STOP (See Motion Function Block: MC_Stop), which is used to stop any 
movement in progress,
MC_RESET (See Motion Function Block: MC_Reset), which is used to initialize 
the function blocks and to acknowledge servodrive faults.

Contents The screen below shows a part of the section to develop. 

The blocks are instantiated to variables input directly in the Instance zone of the 
FFB Input Assistant to facilitate subsequent diagnostics using the animation 
tables.

MC_POWER

MC_POWER_Z

1

Cmd_Run_Z
Axis_Ref_Z

ENABLE

AXIS ERROR

ERRORID
STATUS

MC_STOP

MC_STOP_Z

2

Cmd_Stop_Z

Axis_Ref_Z

EXECUTE

AXIS ERROR
DONE
BUSY

ERRORID
COMMANDABORTED

MC_RESET

MC_RESET_Z

3

Cmd_Reset_Z

Axis_Ref_Z

EXECUTE

AXIS ERROR
DONE
BUSY

ERRORID
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Motion Control

At a Glance This programming section is made up of the following MFB blocks:

MC_HOME (See Motion Function Block: MC_Home), which allows a homing 
reference point to be set for the axis before then launching it in absolute motion,
MC_MOVEABSOLUTE (See Motion Function Block: TE_CAN_Handler), which 
allows the axis to make an absolute movement.
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Application Programming
Contents The screen below shows the part of the section. 

For the tutorial example, the section is made up of a type of sequence of reversing 
movements.

The outward motion is conditioned by the Cmd_Mvt_Z bit from the operator screen 
(see Representation, p. 82).

The return motion is conditioned by the end of the outward motion.

The position unit is USR and the velocity unit is rpm.

MC_MOVEABSOLUTE

ABSOLUTE1_Z

2

Axis_Ref_Z AXIS ERROR

BUSY
DONEEXECUTE

POSITION

VELOCITY
ERRORID

COMMANDABORTED
50000

2000

Cmd_Mvt_Z

ACCELERATION0

DECELERATION0

MC_MOVEABSOLUTE

ABSOLUTE2_Z

3

Axis_Ref_Z AXIS ERROR

BUSY
DONEEXECUTE

POSITION

VELOCITY
ERRORID

COMMANDABORTED
-50000

2000

ACCELERATION0

DECELERATION0

MC_HOME

HOME_Z

1

Axis_Ref_Z AXIS ERROR

BUSY
DONEEXECUTE

POSITION

SPEED
ERRORID

COMMANDABORTED
0

2000

HTYPE34

Cmd_home_Z
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Application Programming
The Homing type HTYPE value (34) corresponds to an homing within a single turn, 
positive direction of rotation.
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Application Programming
Motion Monitoring

At a Glance This section is made up of the MC_READACTUALPOSITION (See Motion Function 
Block: MC_ReadActualPosition) and MC_READACTUALVELOCITY (See Motion 
Function Block: MC_READACTUALVELOCITY) MFB blocks. 

These blocks are used to determine the exact position and speed of the axis.

Contents The screen below shows a part of the section to develop. 

Whilst the Axis_OK_Z bit is enabled, the position and speed values are 
continuously displayed on the operator screen (see Representation, p. 82).

MC_READACTUALVELOCITY

VELOC_Z

2

AXIS_OK_Z
Axis_Ref_Z

ENABLE

AXIS ERROR
VALID
BUSY

ERRORID

MC_READACTUALPOSITION

POSIT_Z

1

Axis_OK_Z
Axis_Ref_Z

ENABLE

AXIS ERROR
VALID
BUSY

ERRORID
POSITION Position_Z

VELOCITY Velocity_Z
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Status and Axis Error Code Section

At a Glance This section is made up of the following MFB blocks:

 MC_READSTATUS (See Motion Function Block: MC_ReadStatus), which is 
used to determine the drive status (See Motion Function Block: Axis Status 
Chart),
 MC_READAXISERROR (See Motion Function Block: MC_ReadAxisError), 
which is used to determine the error values according to the type of errors on the 
drive and to deduce their causes (See Motion Function Block: Table of Error 
Values).
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Application Programming
Contents The screen below shows a part of the section. 

The UPLOAD_Z.ERROR and DOWNLOAD_Z.ERROR variables must be added to the 
OR block after the recipe (see Backup and Transfer of the Servodrive Parameters, 
p. 71) section has been created.

MC_READSTATUS

READSTATUS_Z

1

TRUE
Axis_Ref_Z

ENABLE

AXIS ERROR

BUSY

VALID

ERRORID

STOPPING
ERRORSTOP

STANSTILL

CONTINUOUSMOTION

DISCRETEMOTION

SYNCHRONISEDMOTION

REFERENCED

MOTIONTASKMOTION

DOWNLOADING

DISABLED

HOMING

MC_READAXISERROR

READERROR_Z

2

Axis_Ref_Z

ENABLE

AXIS ERROR

BUSY

VALID

ERRORID

AXISFAULTID
AXISFAULT

AXISDIAG

AXISWARNING

AXISDIAGID

AXISWARNINGID

AXISERRORID
MSGERRORID

OR       3

IN5
IN6

.1

IN7
IN8

HOME_Z.ERROR

ABSOLUTE1_Z.ERROR
ABSOLUTE2_Z.ERROR

UPLOAD_Z.ERROR

IN1
IN2

IN3
IN4

AXIS_OK_Z

MC_STOP_Z.ERROR
MC_RESET_Z.ERROR

MC_POWER_Z.ERROR

IN9

IN10
DOWNLOAD_Z.ERROR

READSTATUS_Z.ERROR
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Backup and Transfer of the Servodrive Parameters

At a Glance This programming section is made up of the following MFB blocks:

 TE_UPLOADDRIVEPARAM (See Motion Function Block: 
TE_UploadDriveParam), which is used to back up the configuration of a 
servodrive in a data table,
 TE_DOWNLOADDRIVEPARAM (See Motion Function Block: 
TE_DownloadDriveParam), which is used to transfer the data table parameters 
to a servodrive.

Contents The screen below shows the Recipe section. 

If Cmd_Upload_Z is enabled, the servodrive configuration is saved in the data table 
Recipe_Z (buffer variable for the recipes).

If Cmd_Download_Z is enabled, the servodrive configuration is restored by the data 
table Recipe_Z.

TE_UPLOADDRIVEPARAM

UPLOAD_Z

1

Cmd_Upload_Z
Axis_Ref_Z

ENABLE

AXIS ERROR
DONE
BUSY

PARAMETERSET
COMMANDABORTED

AxisParamDesc_0 PARAMETERLIST

TE_DOWNLOADDRIVEPARAM

DOWNLOAD_Z

2

Cmd_Download_Z
Axis_Ref_Z

ENABLE

AXIS ERROR
DONE
BUSY

ERRORID
COMMAND...

AxisParamDesc_0
Recipe_Z

PARAMETERLIST

PARAMETERSET

Recipe_Z
SIZE

ERRORID
ERRPARAMNUMBER

ERRPARAMNUMBER
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Application Programming
Transferring the Project between the Terminal and the PLC

At a Glance Transferring a project allows you to copy the current project from the terminal to the 
current PLC’s memory (PLC that has its address selected).

Project Analysis 
and Generation

To perform analysis and generation of a project at the same time, carry out the 
following actions.

Project Backup To back up the project, carry out the following actions.

Step Action

1 Activate the Rebuild All Project command in the Build menu.
Result: the project is analyzed and generated by the software.

2 Any errors detected are displayed in the information window at the bottom of 
your screen.

Step Action

1 Activate the Save As command in the File menu.

2 If necessary, select the directory to which the project will be saved (disk and 
path).

3 Enter the file name: MFB_Lexium05.

4 Confirm with Save.
Result: the project is saved as MFB_Lexium05.STU.
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Application Programming
Transferring the 
Project to the 
PLC

You must carry out the following actions to transfer the current project to a PLC.

Step Action

1 Use the PLC → Define the address command. Enter SYS if you are using a USB media that is directly 
connected from the PC (terminal) to the PLC.

2 Switch to online mode using the PLC → Connection command.

3 Activate the PLC → Transfer Project to PLC command.
Result: the screen used to transfer the project between the terminal and the PLC is displayed. 

4 Activate the Transfer command.

5 If the project has not been generated in advance, the screen below will be displayed allowing you to 
generate it before the transfer (Rebuild All then Transfer) or interrupt the transfer (Cancel Transfer). 

6 Transfer progress is displayed on screen. At any moment, you can interrupt the transfer by using the Esc 
key. In this case, the PLC project will be invalid.
Note: In the event that the project is transferred to a Flash Eprom memory card, the transfer can take 
several minutes. 

Transfer Project to PLC

 Overwritten PLC Project PC Project

Name: Station

Version: 0.0.0

Last build: 05/04/02 15:40:07

Name: [invalid project]

Version:

Last build:

Compatibility:

PLC Run after Transfer

CancelTransfer

Cancel transfer

Transfer Project to PLC

Project is not built.

Rebuild all then transferBuild the project and transfer it
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Application Debugging
At a Glance

Subject of this 
Chapter

This chapter describes the possibilities for debugging the application using Unity Pro 
and PowerSuite for Lexium 05. 

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

Tuning the Lexium 05 with PowerSuite 76

Using Data via the Animation Tables 77

Program Debugging 80

Using Data via the Operator Screens 82
75



Application Debugging
Tuning the Lexium 05 with PowerSuite

In Advance We recommend tuning the axis kinematic before the program automatically starts it.

Tuning Example The following table gives an example of kinematic tuning.

Step Action

1 Connect (see Connecting to the Lexium 05, p. 51) to the Lexium 05.

2 After a connection and transfer of the device’s configurations, PowerSuite opens a new window with the 
configuration screen, which gives access to device control, tuning and monitoring functions.
The following figure shows part of the new window. This lower window provides access to Lexium 05 
command functions. 

3 Place the Command zone cursor on Active.

4 Place the Enable zone cursor on On.

5 Click the Reset button to clear any problems.

6 Click the Test Run button.

7 Enter the value 0,1 in the CUR_I_target zone.

8 Place the CURref zone cursor on On.
Result: the motor runs and the sub-window is animated: 

9 Place the Command zone cursor on Inactive once tuning has been finalized.

   Standard profile en Connected

_p_refusr = 1066883 usr
_p_actusr = 1066883 usr
_n_ref    = 0       1/min
_n_act    = 0       1/min
_ldq_act = 0.03  Apk

Speed control mode
HALT =inactive
S.Fault= 0x0000
Local access
DEVcmdinterf=CANOpen

Command
Active

Inactive

CURref.
On

Off

Enable
On

Off

Min                      Max
-9.90    0.00         9.90

   CUR_I_target[A]

State
[4] ReadyTest run

Test stop Reset

   Standard profile en Connected

_p_refusr = 59241111 usr
_p_actusr = 11997039 usr
_n_ref    = 0              1/min
_n_act    = 1772       1/min
_ldq_act = 0.05         Apk

Current control mode
HALT =inactive
S.Fault= 0x0000
Exclusive Powersuite
DEVcmdinterf=CANOpen

Command
Active

Inactive

CURref.
On

Off

Enable
On

Off

Power

[6] Op Enable
Test run

Test stop Reset

Enabled
 Min                    Max
 -9.90   0.10        9.90

   CUR_I_target[A]
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Application Debugging
Using Data via the Animation Tables

At a Glance The animation table is the Unity Pro’ basic tool for viewing and forcing the status of 
variables.

An animation table is divided into 3 areas that include:

the Mode area
the Command area
the Display area

Animation table: 

Note: Unity Pro also offers a graphic tool called Operator Screens which is 
designed to facilitate  use of the application (see Using Data via the Operator 
Screens, p. 82).

Table

Modify Force

Name Type CommentValue

Mode selection zone Command zone

Display zone
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Application Debugging
Creating an 
Animation Table

The table below presents the procedure for creating an animation table.

Step Action

1 Right-click on the Animation Tables directory in the project browser.
Result: the contextual menu is displayed.

2 Select New Animation Table.
Result: a table properties window is displayed.

3 Click on OK to create the table, which is given a default name.
Result: the animation table is displayed.
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Application Debugging
Adding Data to 
the Animation 
Table

The table below presents the procedure for creating data to view or force in the 
animation table.

Step Action

1 In the Table window, click on the empty line in the Name column.

2 There are two possible ways of adding data:
Enter the variable directly

Click on the  icon to display the instance selection window in order to select the variable

3 Enter or select the respective variables:
Cmd_Home_Z to issue an return axis to home position command,
Cmd_Mvt_Z to issue a move axis command,
Cmd_Run_Z to issue a run axis command,
Cmd_Stop_Z to issue a stop axis command,
Cmd_Reset_Z to issue an axis acknowledgement command,
Cmd_Upload_Z to issue a save axis data to a recipe table command,
Cmd_Download_Z to issue a transfer data from the recipe table to the axis command,
Axis_OK_Z to view the axis recognized by the CANopen bus,
Position_Z to determine the value of the axis position,
Velocity_Z to determine the value of the axis speed.

Result: the animation table looks like this. 

...

Table

Modify Force

Name Type CommentValue
BOOLCmd_Home_Z
BOOLCmd_Mvt_Z
BOOLCmd_Run_Z
BOOLCmd_Stop_Z
BOOLCmd_Reset_Z
BOOLCmd_Upload_Z
BOOLCmd_Download_Z
BOOLAxis_OK_Z
DINTPosition_Z
DINTVelocity_Z
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Application Debugging
Program Debugging

At a Glance After transferring the program and running the axis using Powersuite for Lexium 05,  
the process is commissioned.

An animation table is a commissioning solution used to monitor, modify and/or force 
the values of variables.

The sets of parameters of the axis may be accessed and modified in Unity Pro using 
the MFB messaging blocks MC_READPARAMETER (See Motion Function Block: 
MC_ReadParameter) and MC_WRITEPARAMETER (See Motion Function Block: 
MC_WriteParameter).

Modification 
Mode

The following screen shows the animation table in modification mode. 

This table is used to determine the status of the MC_POWER block’s input and output 
parameters. 

To access this mode, click on the Modify button in the mode selection zone.

Note: This operation may be assigned to other function blocks.

Note: The animation table is dynamic only in online mode (display of variable 
values).

Table

Name Type CommentValue
BOOLCmd_Home_Z
BOOLCmd_Mvt_Z
BOOLCmd_Run_Z
BOOLCmd_Stop_Z
BOOLCmd_Reset_Z
BOOLCmd_Upload_Z
BOOLCmd_Download_Z
BOOLAxis_OK_Z
DINTPosition_Z
DINTVelocity_Z

Modify Force

READSTATUS_Z.REFERENCED BOOL
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Modifying Values The tutorial example uses Boolean variables. To modify a Boolean value, carry out 
the following actions.

Starting the 
System

The following table describes the procedure for starting the system used in the 
example.

Step Action

1 Use the mouse to select the Boolean variable you wish to modify.

2
Click on the  button corresponding to the desired value, or 
execute the Set to 0 or Set to 1 commands in the contextual menu.

Step Action

1 Set the variable Cmd_Run_Z to 1.
Result: the variable Axis_OK_Z changes to 1.

2 Set the variable Cmd_Reset_Z to 1.

3 Set the variable Cmd_Home_Z to 1.
Result: the axis is referenced.

4 To rotate the axis, set the variable Cmd_Mvt_Z to 1.
Result: the axis starts to turn and the values of the variables Position_Z and 
Velocity_Z are no longer set to 0.

5 To stop the axis from rotating:
set the variable Cmd_Stop_Z to 1,
set the variable Cmd_Mvt_Z to 0.

Result : the axis stops rotating.

6 To start to rotate the axis again and complete the movement:
set the variable Cmd_Stop_Z to 0,
set the variable Cmd_Mvt_Z to 1.

Result: the axis starts to rotate again and completes its movement.
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Using Data via the Operator Screens

At a Glance When a project is created, it common for there to be no input cards, output cards 
and supervision. To lessen the impact of this problem, using the Unity Pro operator 
screen associated with unlocated bits and words allows you to carry out initial 
debugging of the program.

In the tutorial example, the operator screen is used to:

view data from the servodrives,
send commands to the servodrives.

Representation The representation below symbolizes the operating example which is used to control 
the axis and indicate the variables to be assigned to the objects (push button, LED 
and text). 

Axis_OK
AXIS_Z

Motion

Home

Run

Reset

Stop

Text

UpLoad Z

DownLoad Z

Position

Commands

Text

Speed

Cmd_Run_Z

Cmd_Reset_Z

Cmd_Home_Z

Cmd_Mvt_Z

Cmd_Stop_Z

Cmd_Upload_Z

Cmd_Download_Z

Velocity_Z

Position_Z
Axis_OK_Z
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Operating the Application
Management of the Recipes

At a Glance The TE_UPLOADDRIVEPARAM (See Motion Function Block: 
TE_UploadDriveParam) and TE_DOWNLOADDRIVEPARAM (See Motion 
Function Block: TE_DownloadDriveParam) blocks are used to manage the 
production recipes.

An example of the procedure for creating and managing recipes is described in this 
section.

Note: For flexible machines, it is possible to manage several parameter recipes.
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Operating the Application
Creating and 
backing up the 
recipes

The table describes the procedure for creating recipes.

Step Action

1 Create the recipes (see Axis Creation and Configuration, p. 40) using the 
Axis_Z directory.
Result: new recipe variables (Recipe_0, Recipe_1, etc.) are automatically 
created in the Data Editor (see In the Data Editor, p. 48).

2 Create a variable corresponding to the type of recipe variables.
This variable is named in the Recipe_Z tutorial example.
Recipe_Z acts as a buffer when backing up or transferring data.
Note: It is essential to check Allow dynamic arrays [ANY_ARRAY_XXX] 
located in Tools → Project options → Tab: Language extensions → Zone: 
Data type to be able to use table type variables such as the recipes.

3 Configure the servodrive’s parameters using Powersuite (see Configuring the 
Lexium 05 in PowerSuite, p. 50).
These initial settings are used to configure a recipe.

4 Perform a backup of the parameters using the TE_UPLOADDRIVEPARAM 
(See Motion Function Block: TE_UploadDriveParam) block in the buffer 
variable Recipe_Z.
The backup was successful if the bits of the MC_READSTATUS (See Motion 
Function Block: MC_ReadStatus) block are as follows:

DOWNLOADING (See Motion Function Block: Axis Status Chart) is set to 0,
STANDSTILL (See Motion Function Block: Axis Status Chart) is set to 1.

5 Transfer the data backed up in the Recipe_Z buffer variable to the Recipe_0 
variable.

6 Repeat steps 3 and 4 to transfer the data backed up in the Recipe_Z buffer 
variable to the Recipe_1 variable.
The following programming presents a data transfer example based on the 
value of PRODUCTION:
IF UPLOAD_Z.DONE AND PRODUCTION=0 THEN
Recipe_0:=Recipe_Z;
END_IF; 
IF UPLOAD_Z.DONE AND PRODUCTION=1 THEN
Recipe_1:=Recipe_Z;
END_IF; 
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Operating the Application
Transfer Data 
from the Recipes

The table describes the procedure to transfer recipe data to the servodrive (for a 
production change, for example).

Step Action

1 Reload the Recipe_Z buffer variable based on the value of PRODUCTION 
(type of production requested).
IF Cmd_Download_Z AND PRODUCTION=0 THEN
Recipe_Z:=Recipe_0;
END_IF; 
IF Cmd_Download_Z AND PRODUCTION=1 THEN
Recipe_Z:=Recipe_1;
END_IF; 

2 Transfer the parameter data, using the Recipe_Zbuffer variable’s 
TE_DOWNLOADDRIVEPARAM (See Motion Function Block: 
TE_UploadDriveParam) block, to the servodrive.

3 The transfer was successful if the bits of the MC_READSTATUS (See Motion 
Function Block: MC_ReadStatus) block are as follows:

DOWNLOADING (See Motion Function Block: Axis Status Chart) is set to 0,
STANDSTILL (See Motion Function Block: Axis Status Chart) is set to 1.
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Application Maintenance
At a Glance

Subject of this 
Chapter

This chapter describes the procedure involved in replacing a servodrive after a fault 
has been diagnosed.

What's in this 
Chapter?

This chapter contains the following topics:

Topic Page

Error Example 88

Replacing a Faulty Servodrive 90
87



Maintenance
Error Example

At a Glance The MC_ReadAxisError function is used to recover system errors.

If an error or warning occurs, the block specifies a code by applying a value to the 
AXISFAULTID, AXISDIAGID and AXISWARNINGID output parameters.

Error Codes The following table shows the Lexium 05 error codes:

Lexium 05

AxisFaultId SigLatched 
301C:08

AxisDiagId WarnLatched 
301C:0C

AxisWarningId StopFault 603F:0

Note: Refer to the CANopen documentation for Lexium 05 to identify the error.
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Maintenance
Finding Errors The table below describes a procedure for finding faults following an error or warning 
code.

Step Action

1 The AxisFault output parameter equals 1.
The AxisFaultId output parameter displays an error value.
The graph below shows the error generated. 

2 Refer to the CANopen documentation of the Lexium 05 and look for the code SigLatched 301C:08.

3 The AxisFaultID value is set to 4194304. This binary value means that bit 22 is set to one.
Refer to the CANopen documentation of the Lexium 05 and look for the code ‘SigLatched’ 301C:08.
Bit 22 for ‘SigLatched’ designates a lag error.

4 Reduce the speed constants in absolute block or external load or acceleration.

5 Execute the MC_Reset block.

MC_ReadAxisError

Axis_Ref Axis
Enable

Error
Valid
Busy

ErrorId

AxisWarning

AxisDiag
AxisFaultId 4194304

AxisWarningId

MSGErrorId
AxisErrorId

0

0
9

AxisFault

AxisDiagId 41760

0

OR       3

IN5
IN6

.1

IN7
IN8

HOME_Z.ERROR

ABSOLUTE1_Z.ERROR
ABSOLUTE2_Z.ERROR

UPLOAD_Z.ERROR

IN1
IN2

IN3
IN4

AXIS_OK_Z

MC_STOP_Z.ERROR
MC_RESET_Z.ERROR

MC_POWER_Z.ERROR

IN9

IN10
DOWNLOAD_Z.ERROR

READSTATUS_Z.ERROR

OUT
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Replacing a Faulty Servodrive

At a Glance If the servodrive fails, it may be necessary to swap it for an identical servodrive 
(reference). To do this, you are advised to save the adjustment parameters to a data 
table using the TE_UPLOADDRIVEPARAMETER (See Motion Function Block: 
TE_UploadDriveParam) block. 

The TE_DOWNLOADDRIVEPARAM (see Backup and Transfer of the Servodrive 
Parameters, p. 71) block then allows you to restore the saved data to a new 
servodrive.

Data Backup The table below describes the procedure used to back up the servodrive’s data 
using the TE_UPLOADDRIVEPARAMETER (See Motion Function Block: 
TE_UploadDriveParam) block.

Step Action

1 Disable the Enable parameter, which belongs to the MC_POWER (See Motion 
Function Block: MC_Power) block.
Result: the servodrive switches to Disable (See Motion Function Block: Axis 
Status Chart) mode.

2 Enable the input parameter Execute.
Result: the servodrive switches to Downloading (See Motion Function Block: 
Axis Status Chart) mode.
The data table assigned to the output parameter PARAMETERSET is filled in.
Note: Please back up data to a .DAT file using PLC → Transfer PLC data to 
the file  if the PLC has no memory card.
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Restoring Data The table below describes the procedure used to restore the servodrive’s data using 
the TE_DOWNLOADDRIVEPARAM (see Backup and Transfer of the Servodrive 
Parameters, p. 71) block.

Step Action

1 Disable the Enable parameter, which belongs to the MC_POWER (See Motion 
Function Block: MC_Power) block.
Result: the servodrive switches to Disable (See Motion Function Block: Axis 
Status Chart) mode.

2 Change the servodrive. The new servodrive must have the same references as 
the faulty servodrive.
Note: Make sure you take all the necessary precautions when changing the 
servodrive.

3 Configure the new servodrive with the basic parameters (see Configuring the 
Lexium 05 in PowerSuite, p. 50) (CANopen address, speed) or using the keypad 
on the front panel.

4 Enable the block’s input parameter Execute.
Result: the servodrive switches to Downloading (See Motion Function Block: 
Axis Status Chart) mode.
The data table assigned to the input parameter PARAMETERSET loads the input 
PARAMETERLIST which corresponds to the servodrive parameter.
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II

Multi-Axis Application
At a Glance

Aim of this Part This part describes the other hardware available for the Motion Function Blocks offer 
with a Modicon M340 running Unity Pro.

The Lexium 05 servodrive was used in the previous part to carry out an example. 
This part begins with a presentation of the following servodrives in a full architecture:

Lexium 15
ATV 31
ATV 71
IclA

Following this presentation, configuration of each of the servodrives is described, 
detailing differences with the Lexium 05 so as to carry out the same example.

What's in this 
Part?

This part contains the following chapters:

Chapter Chapter Name Page

7 Foreword 95

8 Lexium 15MP/HP/LP Implementation for Motion Function 
Blocks

97

9 ATV 31 Implementation for Motion Function Blocks 121

10 ATV 71 Implementation for Motion Function Blocks 137

11 IclA Implementation for Motion Function Blocks 155
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Foreword
Application Architecture with All Servodrives

Overview Following is a presentation of the usage of available hardware (servodrives), via an 
architecture, for implementing Motion Function Blocks in Unity Pro.
95



Foreword
Illustration The following figure shows the architecture used in the application that includes all 
servodrives. 

ATV 31LEXIUM  05

Unity Pro

LEXIUM  15••

CANopen

ATV 71

IclA

Easy 
IclA 

PowerSuite
for ATV 71 

PowerSuite
for ATV 31

and 
for Lexium 05 

Unilink 
L/MH

ID 3

ID 2 ID 4

ID 5

ID 6

Junction box

Modicon M340

LXM 
15LP 
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8

Lexium 15MP/HP/LP Implemen-
tation for Motion Function Blocks
At a Glance

Aim of this 
Chapter

This chapter presents the implementation of Lexium 15MP/HP/LP servodrives 
according to the methodology (See Methodology, p. 17) described in the quick start 
guide (See Start-up Guide for a Single Axis Application, p. 13) with a Lexium 05. It 
only details the differences and actions for Lexium 15MP/HP/LP.

What's in this 
Chapter?

This chapter contains the following sections:

Section Topic Page

8.1 Adapting the Application to the Lexium 15MP/HP/LP 98

8.2 CANopen Bus Configuration Lexium 15MP/HP/LP 102

8.3 Configuring the Lexium 15MP/HP/LP 106

8.4 Tuning the Lexium 15MP/HP/LP 117
97
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8.1 Adapting the Application to the 
Lexium 15MP/HP/LP

At a Glance

Aim of this 
Section

This section presents adaptation of the application to the Lexium 15MP/HP/LP with 
an architecture, and hardware and software requirements.

What's in this 
Section?

This section contains the following topics:

Topic Page

Application Architecture with Lexium 15MP/HP/LP 99

Software Requirements 100

Hardware Requirements 101
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Application Architecture with Lexium 15MP/HP/LP

At a Glance The proposed structure represents a simple structure which is designed to 
assimilate the motion control implementation principles.

This realistic structure may well be expanded upon with other devices in order to 
manage several axes.

Illustration The figure below shows the structure used in the application. 

Line terminator

Unilink 
L/MH 

LEXIUM  15••

CANopen

BSH or BDH
Motor••

Unity Pro

Modicon M340
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Software Requirements

Overview As regards the software requirements presented in the quick start guide (See 
Software Requirements, p. 23), PowerSuite is used for configuring and tuning the 
Lexium 05.

PowerSuite for Lexium 05 enables on-lining of the axis and guarantees a simple 
method for configuring the parameters of a Lexium 05 servodrive. Unilink L/MH for 
Lexium 15•• does the same, but for Lexium 15•• servodrive.

Functional 
Diagram for the 
Lexium 15••

The following diagram shows the different functions performed by the PLC and the 
servodrive. 

Versions The following table lists the hardware and software versions used in the architecture 
(See Application Architecture with Lexium 15MP/HP/LP, p. 99), enabling the use of 
MFBs in Unity Pro.

Unity Pro

Servodrive 
Lexium 15••

Motion Tasks

Sets of 
parameters

PLC

Application
program

(MFB)

BSH or BDH
Motor••

Speed
Position

UnilinkL/MH

Device Software version used in the 
example

Earliest version of firmware

Modicon M340 Unity Pro V3.0 -

Lexium 15LP Unilink V1.5 V1.45

Lexium 15MH Unilink V4.0 V6.64
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Hardware Requirements

References of 
the Hardware 
Used

The following table lists the hardware used in the architecture (See Application 
Architecture with Lexium 15MP/HP/LP, p. 99), enabling implementation of 
Lexium 15MP MFBs in Unity Pro.

The following table lists the hardware used in the architecture (See Application 
Architecture with Lexium 15MP/HP/LP, p. 99), enabling implementation of 
Lexium 15LP MFBs in Unity Pro.

Hardware Brand Reference

Modicon M340 PLC Telemecanique BMX P34 2030

Modicon M340 power supply Telemecanique BMX CPS 2000

Modicon M340 rack Telemecanique BMX XBP 0800

Lexium 15MP Servodrive Telemecanique LXM15MD28N4

Lexium 15MP connection 
cable to CANopen port of the 
PLC

Telemecanique TLA CD CBA •••

CANopen connector for 
Lexium 15MP

Telemecanique AM0 2CA 001 V000

Motor for Lexium 15MP Telemecanique BPH055••

Hardware Brand Reference

Modicon M340 PLC Telemecanique BMX P34 2030

Modicon M340 power supply Telemecanique BMX CPS 2000

Modicon M340 rack Telemecanique BMX XBP 0800

Lexium 15LP Servodrive Telemecanique LXM15LD13M3

Lexium 15MP connection 
cable to CANopen port of the 
PLC

Telemecanique TLA CD CBA •••

CANopen connector for 
Lexium 15LP

Telemecanique AM0 2CA 001 V000

Motor for Lexium 15LP Telemecanique AKM 31E

Note: The line terminator is an interrupter built into the AM0 2CA 001 V000 
CANopen connector.
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8.2 CANopen Bus Configuration Lexium 15MP/HP/LP

Configuration of the CANopen Slave on CANopen bus

Overview The implementation methodology for a CANopen bus using Modicon M340 is to:

configure (See Configuration of the CANopen port, p. 31) the CANopen port of 
the CPU,
declarate the slave chosen from the hardware catalog (See paragraph bellow),
configure the slave,
enable the configuration using Unity Pro,
check (See Checking the CANopen Bus Configuration, p. 36) the CANopen bus 
in the Project browser.
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How to Configure 
the CANopen 
Slave

This table describes the procedure to configure the CANopen slave.

Step Action

1 In the Unity Pro Project Browser, fully expand the Configuration directory and then double-click on 
CANopen.
Result: The CANopen window appears. 

CANopen

Bus: CANopen comm head 01.003 Connections configured: 0
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2 Select Edit → New device.
Result: The New Device window appears. 

3 Set 3 in Topological Address.
For the slave device choose Lexium15LP_V1_4 for a Lexium 15LP or Lexium15MH_V6_61for a 
Lexium 15MP.

Step Action

Part Number Description
CANopen drop

ATV31_V1_1
ATV31_V1_2
ATV31T_V1_3
ATV61_V1_1

New Device

OK

Cancel

HelpDiscrete
Motion

Topological Adress:        [1..63] 

Altivar 31 CANopen Slave DSP402 (TEATV3111E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV31T13E.eds)
ATV61 (TEATV6111E.eds)

ATV71_V1_1 ATV71 (TEATV7111E.eds)
IclA_IFA IclA-IFA CANopen (IclA-IFA.eds)
IclA_IFE IclA-IFE CANopen (IclA-IFE.eds)
IclA_IFS IclA-IFS CANopen (IclA-IFS.eds)

Lexium15LP_V1_4 EDS for Lexium 15LP servodrive (TELXM15LP_0142.eds) 
Lexium15MH_V6_61 EDS for Lexium 15MPHP servodrive (TELXM15MH_0661E.eds)
Osicoder Osicoder - absolute rotary multi-turn encoders (TEXCC3B_0100E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV3112E.eds)

Node-ID:
3
3

IclA_N065 IclAN065 based on profiles DS301V4.01 and DSP402.V2.0 (BLIC....
Lexium05 DCX170 CANopen (TEDCX107_0100E.eds)
Lexium05_MFB LXM05A PLCopen (LEXIUM05_MFB.EDS)

Other

Drop end communicator
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4 Click on OK to confirm the choice.
Result: The CANopen window appears with the new device selected. 

5 Select Edit → Open module.
If MFB has not already been selected, choose it in the Function area.

6 You will be asked to validate your modifications when closing the Device and CANopen windows.

Step Action

CANopen

Bus: CANopen comm head 01.003 Connections configured: 1

3 0

...

LXM 
15LP 
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8.3 Configuring the Lexium 15MP/HP/LP

At a Glance

Aim of this 
Section

This section describes the basic servodrive configurations using Unilink L/MH for 
Lexium 15MP/HP/LP.

What's in this 
Section?

This section contains the following topics:

Topic Page

Basic Parameters for Lexium 15MP using Unilink MH 107

Basic Parameters for Lexium 15LP using Unilink L 110

Specific Parameters for Lexium 15 MP/HP/LP using Unilink 115
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Basic Parameters for Lexium 15MP using Unilink MH

At a Glance Unilink is a commissioning tool for axes intended for motion control applications.

Its graphic user interface provides a simple method for configuring the parameters 
of a Lexium 15MP-type servodrive.

Connecting to 
Lexium 15MP

This table describes the procedure for connecting to Lexium 15MP.

Step Action

1 Start Unilink MH via Start → Program → Unilink → Unilink MH.
A communication window is displayed on main window of Unilink MH: 

If the port that you are using is available (i.e. is not being used by other devices or programs), the name COM1, 
COM2, COM3, COM4, COM5, COM6, COM7, COM 8, COM9, COM10 appears in black. Otherwise, it appears 
in grey.

COM1

COM2

COM3

COM4

Offline

COM6

COM7

COM8

COM9

Disconnect 
Interfaces

COM5 COM10
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2 Click on one of these communication ports (the port that you use on your PC) to transfer the values of the 
servodrive parameters to your PC. 
When communication has been established, this general screen appears: 

Step Action

Servodrive 2 “DRIVE0”

Fault Exit

R
A E2

CLEA

R
A E2

SAVMONI
ST Basic Setup

Slot

Analog I/O

Speed

Position

Input

Current

Resolver

Motor selection

Digital I/O

Motor

Feedback

Torque

ROD / SSI / Encoder

2,3

4,5,8

0,1

0: Digital speed
OPMODE

Servodrive 
Configuration

Axis

Disabled
SW

Disable (F12) Enable (Shift+F12)
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Basic 
Parameters

This table describes the procedure for inputting the basic parameters.

Step Action

1 Click on the Basic Setup button in the general screen.
The Basic Setup window appears. 

This screen is used to set parameters for the servodrive’s CANopen address, 
the bus speed and the units used for acceleration, speed and position.

2 For the tutorial example, from this screen set or select the following:
In the servodrive zone:

the CANopen address to 2
the baud rate of the bus to 500 Kbaud (See Configuration of the 
CANopen port, p. 31)

In the Unit (See Motion Function Block: Units and Servodrives) zone:
the acceleration in ms->VLIM
the speed in rpm
the position in μm

3 Click on the Motor Selection, Current, Resolver buttons to declare the motor 
and the feedback parameters.
Note: for information on how to declare the motor correctly, please refer to the 
motor documentation.

4 Click OK to confirm the basic configuration.
Result: The basic setup is saved and the main screen is displayed again.
Note: When certain ASCII parameters have been enabled, a window appears 
asking you to save changes to the servodrive’s EEPROM memory. Click on OK 
to restart the servodrive and update the memory. 

5 Click on Exit.

03

Basic Setup 01

OK

230 V

Software Version

Auxiliary Power Supply

Servodrive

Cancel Apply

V3.5 KS283

Internal

No message

Regen resistor

Regen power

Max. Mains Voltage

Mains phase 
missing

W

Hardware

h
Run time

Serial number

Firmware

Name

BaudrateAddress

Units

ms->VLIM Rpm µm
Acceleration Speed Position

Fieldbus address

Off 
Auto Ext. WD

500 Kbaud

DRIVE0

Drive 1A Hardware Version 49.01

V6.63 DRIVE Rev created xxxxx

3427:0

770269611
80

600
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Basic Parameters for Lexium 15LP using Unilink L

At a Glance Unilink is a commissioning tool for axes intended for motion control applications.

Its graphic user interface provides a simple method for configuring the parameters 
of a Lexium 15LP-type servodrive.

Connecting to 
Lexium 15LP

This table describes the procedure for connecting to Lexium 15LP.

Step Action

1 Start Unilink L via Start → Program → Unilink → Unilink L.
Result: A window ask you if you would like to connect to the drive

2 Click on the Yes button.
Result: A window to select the device appears.

3 Select RS-232 and click on the OK button.
Result: A window of RS-232 settings appears.

4 Set the serial port (COM1 to COM10), the Baud Rate (38400), the Timeout (2000ms).
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5 Click on the OK button.
Result: Unilink L software appears. 

Step Action

??? 0: Digital Velocity
Edit Communication Drive Tools View HelpFile

Ready

OP-??? STOP ENEN DISDIS CLR
FLT
CLR
FLT

OnLine NUM

Untitled - Unilink L 

Disabled Warning not normed

Count

Omec
Count

Count

Setup Wizard
Basic Setup
Units / Mechanical

Motion Service
Statusi

Homing
V

t Motion Tasks
Oscilloscope
Bode Plot
Terminal

Monitor

CAN / Field Bus Set-
Feedback
Motor
Current Loop
Velocity Loop
Position Loop
Position Data
Position Registers
Electronic Gearing
Encoder Emulation
Analog I/O
Digital I/O

DRIVE0

Unk
L

Next >

0
Name

Response to loss Input Phase
Three-Phase (Current Limit), 

Mains Voltage
230

Internal

External

Set Software-Enable on Bootup

 Power Supply
 Regen Resistor

V

0
Value

Ohms

50
max. Regen Power

W

0
Serial 

xxxx:xx
Run Time

 Amplifier
Hardware
Drive 3A 
Firmware
V1.23 DRIVE Rev create.d Aug 09 16:56:39 

Browser Main Frame
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Basic 
Parameters

This table describes the procedure for inputting the basic parameters.

Step Action

1 Click on the Setup wizard on the browser.
Result: The Drive Setup screen in the main frame appears: 

2 Select the Complete Setup on the screen.
Result: the browser with all configurations links appears.

3 Click on the Basic Setup on the browser.
Result: the Basic Setup screen in the main frame appears: 

This screen is used to set parameters of the power supply.

 Select Type of Setup Wizard

Welcome to the Drive Setup 

Complete Setup

Gearing Application Setup
Analog Application Setup
Quick Motor/Drive Setup

Motion Task Application Setup

This Setup Wisard will help you configure your drive. Start by choosing the type of 
set up from the list below: “Quick Motor/Drive Setup”, “Analog Application Setup”, 
“Gearing Application Setup”, “Motion Task Application Setup” or “Complete Setup”.

Click “Next” and “Previous” to move between screens, or move directly to any 
screen by clicking in the tree on the left. Click the “Refresh” toolbar button to bring 
back the original data for the screen currently showing.

0
Name

Response to loss Input Phase
Three-Phase (Current Limit), 

Mains Voltage
230

Internal

External

Set Software-Enable on Bootup

 Power Supply
 Regen Resistor

V

0
Value

Ohms

50
max. Regen Power

W 0
Serial 

xxxx:xx
Run Time

 Amplifier
Hardware
Drive 3A 
Firmware
V1.23 DRIVE Rev create.d Aug 09 16:56:39 
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4 Click on the Units/Mechanical on the browser.
The Units/Mechanical screen in the main frame appears. 

For the tutorial example, from this screen set or select the following:
In the User Units zone:

the acceleration in ms->VLIM
the speed in rpm
the position in μm

5 Click on the CAN / Field Bus Settings on the browser.
The CAN / Field Bus Settings screen in the main frame appears: 

For the tutorial example, from this screen set or select the following:
In the General Field Bus and CAN Bus Settings zones:

the CANopen address to 3
the baud rate of the bus to 500 Kbauds

Step Action

10000
Resolution =

Counts

Position

 User Units

rpm (Velocity Loop), Counts/s (Position Loop)

Velocity

μm

ms->VLIM

Acceleration

 Mechanical Conversion

1 Motor Revs

3
Address

kBaud
Baud Rate

500

100
External Watchlog (Fieldbus)

ms

 General Field Bus Settings

 CAN Bus Settings
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6 Click on the Motor, Resolver folders on the browser to declare the motor and the 
feedback parameters.
Note: For information on how to declare the motor correctly, please refer to the 
motor documentation.

7 Save the parameters via Drive → Save to EEPROM.
Result: The basic setup is saved and the main screen is displayed again.

Step Action
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Specific Parameters for Lexium 15 MP/HP/LP using Unilink

At a Glance Specific parameters are entered in addition to the basicparameters. These specific 
parameters supplement the configuration of Lexium 15 MP/HP/LP by modifying 
certain ASCII codes using the Terminal window.

Specific 
Parameters

This table describes the procedure for inputting the specific parameters of 
Lexium 15 MP/HP/LP.

Step Action

1

Click on the  Terminal icon on the general page.
The Terminal window is displayed: 

This screen is used to fully configure the connection point of a Lexium
15MP/HP/LP.

2 For Lexium 15 MP/HP i enter in the Command field: 
DRVCNFG 1050670

For Lexium 15 LP enter in the Command field:
INPT2  x1.5 task time either MAST or FAST 

3 Click on Apply to confirm the configuration of this ASCII parameter.

4 For Lexium 15 MP/HP repeat the steps by entering in the Command field: 
DRVCNFG2  64
INPT x1.5 task time MAST or FAST
ENGAGE  1

Terminal 3 “DRIVE0”

OK Cancel Apply

Command: DRVCNFG 1050670
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Command Enter the ASCII command here, with the corresponding parameters. Confirm the 
entry with RETURN or press the APPLY button to start the transmission.

5 Click on OK to confirm the last Command and return to the general page.

6

Click on the  Save icon on the general page to save the basic and specific 

parameters to the servodrive’s EEPROM memory.

7 Close the general window and click on DIS to disconnect from the servodrive.

Step Action

R
A E2

SAV

The terminal software should be used only by experts.

Failure to follow this instruction can result in injury or equipment damage.

CAUTION
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8.4 Tuning the Lexium 15MP/HP/LP

Debugging the axis

Pre-requisite You are recommended to debug the axis dynamics before it is automatically started 
by the program.

Description The oscilloscope is one way of carrying out the debug operation.

It allows you to:

display up to three variables simultaneously, as a function of time

save the recorded measurements to a data medium in CSV format (can be used 
with MS-Excel)

load a CSV data file and restore the curves on the oscilloscope diagram

use certain services

Illustration for 
Lexium 15MH

The screen below can be accessed by clicking on the Unilink MH menu’s Tools → 
Oscilloscope. 

Oscilloscope 101

Default 
values

Close

Recording
Resolution Trigger level

Start

Cancel Load

Save

Ready V_Ref.

v_act

I_act

V_Ref.

50% Positive

0
Trigger edgeTrigger position

Trigger signal

Time/Division
10

normal

Parameters
Service

Speed   F6 Start Stop (F9)

1:
2:
3:

Rpm
A

1 1 1

0 0 0

-1 -1 -1
0.002 0.004 0.006 0.008

ms

Channel min. max.

Refresh

Auto 

Mem.
35013563 01 November 2007 117



Lexium 15MP/HP/LP for MFBs
How to start 
service for 
Lexium 15MH

The table below explains how to use a service function with a Lexium 15MH.

Illustration for 
Lexium 15LP

The screen below can be accessed by clicking the folder Oscilloscope on the 
Unilink L browser’s. 

Step Action

1 On the field Service, select one of the service functions (see Service 
Functions, p. 119) described below. 

2 Click on the Parameters button.

3 Set the corresponding parameter.

4 Then start the function by using the Start button.

5 The function will continue to be performed until you click on the  Stop button or 
press the function key F9.

5002050005000

VA1m
in

1m
in

2500.000

0-20-5000-5000
0.100 0.200 0.300 0.400

Zeit
K.1: n_ist
K.1: n_sol
K.1: n_ist
K.1: n_VBUS

Auto-Svaling Mode...Auto-scale

Motion Service TuningChannels Trigger  Recording / Scope Files

v_cmdChanel 1
normal
Resolution

100
Time/Div

ms

Auto-Svaling Mode...Auto-scalev_actChanel 2
Auto-Svaling Mode...Auto-scaleI_cmdChanel 3
Auto-Svaling Mode...Auto-scaleI_actChanel 4

Restore
Oscillo-

Record-

Refresh

Start
StopSto
118 35013563 01 November 2007



Lexium 15MP/HP/LP for MFBs
How to start 
service for 
Lexium 15LP

The table below explains how to use a service function with a Lexium 15LP.

Service 
Functions

The table below explains how to use a service function.

Step Action

1 Click on the Motion Services tab.. 

2 Select one of the service functions (See Service Functions, p. 119) described 
below. 

3 Click on the Parameters button.

4 Set the corresponding parameter.

5 Then start the function by using the Start button.

6 The function will continue to be performed until you click on the  Stop button.

Direct current Apply a direct current to the motor with adjustable size and electrical field-
vector angle. The changeover from speed control to current control is made 
automatically, commutation is made independently of the feedback 
(resolver or similar). The rotor locks onto a stator pole.

Speed Operates the drive at constant speed. An internal digital setpoint is provided 
(speed is adjustable).

Torque Operates the drive with constant current. An internal digital setpoint is 
provided (current is adjustable). The changeover from speed control to 
current control is made automatically, commutation is made independently 
of the feedback (resolver or similar).

Reversing 
mode

Operates the drive in reversing mode, with separately adjustable speed and 
reversing time for each direction of rotation.

Motion task Starts the motion task that is selected in the screen page "Entry of service 
parameters".

Zero Function used for feedback setting in conjunction with the positioning 
phase. This function can only be accessed in OMODE2.

Note: For further information, please refer to the Unilink software user manual.

Note: Once the parameters have been correctly set, you are advised to save them 
in EEPROM and to make a backup copy of them in a file.
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9

ATV 31 Implementation for Motion 
Function Blocks
At a Glance

Aim of this 
Chapter

This chapter presents the implementation of an ATV 31 servodrive according to the 
methodology (see Methodology, p. 17) described in the quick start guide (see Start-
up Guide for a Single Axis Application, p. 13) with a Lexium 05. It only details the 
differences and actions for an ATV 31.

What's in this 
Chapter?

This chapter contains the following sections:

Section Topic Page

9.1 Adapting the Application to the ATV 31 123

9.2 CANopen Bus Configuration ATV 31 127

9.3 Configuring the ATV 31 130

9.4 Tuning the ATV 31 136
121
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9.1 Adapting the Application to the ATV 31

At a Glance

Aim of this 
Section

This section presents adaptation of the application to the ATV 31 with an 
architecture, and hardware and software requirements.

What's in this 
Section?

This section contains the following topics:

Topic Page

Application Architecture with an ATV 31 124

Software Requirements 125

Hardware Requirements 126
35013563 01 November 2007 123
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Application Architecture with an ATV 31

Overview The proposed architecture is simple and designed to assimilate the implementation 
principles of motion control.

Other equipment can be added to this realistic architecture in order to manage 
several axes.

Illustration The following figure shows the architecture used in the application that includes an 
ATV 31. 

Modicon M340

    ATV 31

Unity Pro

PowerSuite for 
ATV 31 

CANopen

Junction 

ATV31_V1_1
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Software Requirements

Overview As regards the software requirements presented in the quick start guide (see Start-
up Guide for a Single Axis Application, p. 13), PowerSuite is used for configuring 
and tuning the ATV 31.

Powersuite for Lexium 05 enables on-lining of the axis and guarantees a simple 
method for configuring the parameters of a Lexium 05 servodrive. PowerSuite for 
ATV 31 does the same, but for an ATV 31 servodrive.

It is nonetheless possible to go without PowerSuite in certain cases by using the 
ATV 31 front panel user interface (see Configuring the ATV 31 with the User 
Interface, p. 134).

Versions The following table lists the hardware and software versions used in the architecture 
(see Application Architecture with an ATV 31, p. 124), enabling the use of MFBs in 
Unity Pro.

Hardware Earliest version of software Earliest version of firmware

Modicon M340 Unity Pro V3.0 -

ATV 31 PowerSuite for ATV 31 V2.00 V1.1
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Hardware Requirements

References of 
the Hardware 
Used

The following table lists the hardware used in the architecture (see Application 
Architecture with an ATV 31, p. 124), enabling implementation of ATV 31 MFBs in 
Unity Pro.

Hardware Brand Reference

Modicon M340 PLC Telemecanique BMX P34 2030

Modicon M340 power supply Telemecanique BMX CPS 2000

Modicon M340 rack Telemecanique BMX XBP 0800

CANopen junction box 
between the  Modicon M340 
and ATV 31 servodrive

Telemecanique VW3CANTAP2

PC connection kit Telemecanique VW3A8106

ATV 31 servodrive - ATV31H037M2

Note: The terminating resistor is integrated in the junction box and must be ON.
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9.2 CANopen Bus Configuration ATV 31

Configuration of the CANopen Slave (ATV 31) on CANopen bus

Overview The implementation methodology for a CANopen bus using Modicon M340 is to:

configure (see Configuration of the CANopen port, p. 31) the CANopen port of the 
CPU,
declarate the slave chosen from the hardware catalog (see paragraph bellow),
configure the slave,
enable the configuration using Unity Pro,
check (see Checking the CANopen Bus Configuration, p. 36) the CANopen bus 
in the Project browser.
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How to Configure 
the CANopen 
Slave

This table describes the procedure to configure the CANopen slave.

Step Action

1 In the Unity Pro Project Browser, fully expand the Configuration directory and then 
double-click on CANopen.
Result: The CANopen window appears: 

2 Select Edit → New device.
Result: The New Device window appears: 

3 Set 4 in Topological Address.
For the slave device choose ATV31_V1_2.

CANopen

Bus: CANopen comm head 01.003 Connections configured: 0

Part Number Description
CANopen drop

ATV31_V1_1
ATV31_V1_2
ATV31T_V1_3
ATV61_V1_1

New Device

OK

Cancel

HelpDiscrete
Motion

Topological Adress:        [1..63] 

Altivar 31 CANopen Slave DSP402 (TEATV3111E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV31T13E.eds)
ATV61 (TEATV6111E.eds)

ATV71_V1_1 ATV71 (TEATV7111E.eds)
IclA_IFA IclA-IFA CANopen (IclA-IFA.eds)
IclA_IFE IclA-IFE CANopen (IclA-IFE.eds)
IclA_IFS IclA-IFS CANopen (IclA-IFS.eds)

Lexium15LP_V1_4 EDS for Lexium 15LP servodrive (TELXM15LP_0142.eds) 
Lexium15MH_V6_61 EDS for Lexium 15MPHP servodrive (TELXM15MH_0661E.eds)
Osicoder Osicoder - absolute rotary multi-turn encoders (TEXCC3B_0100E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV3112E.eds)

Node-ID:
3
3

IclA_N065 IclAN065 based on profiles DS301V4.01 and DSP402.V2.0 (BLIC....
Lexium05 DCX170 CANopen (TEDCX107_0100E.eds)
Lexium05_MFB LXM05A PLCopen (LEXIUM05_MFB.EDS)

Other

Drop end communicator
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4 Click on OK to confirm the choice.
Result: The CANopen window appears with the new device selected: 

5 Select Edit → Open module.
If MFB has not already been selected, choose it in the Function area.

6 You will be asked to validate your modifications when closing the Device and CANopen 
windows.

Step Action

CANopen

Bus: CANopen comm head 01.003 Connections configured: 1

4 0

...

LXM15MH
V6
61

ATV31_V1_1
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9.3 Configuring the ATV 31

At a Glance

Aim of this 
Section

This section describes the basic servodrive configurations using PowerSuite for 
ATV 31 and the servodrive’s front panel user interface.

What's in this 
Section?

This section contains the following topics:

Topic Page

Configuring the ATV 31 in PowerSuite 131

Configuring the ATV 31 with the User Interface 134
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Configuring the ATV 31 in PowerSuite

Overview With PowerSuite, users can define installed device bases, and describe their 
associated configurations and communication settings.

PowerSuite then gives access to a group of actions for editing or transferring the 
configurations and for connecting to the devices.

PowerSuite’s navigation principle associates a configuration interface with each 
device type, making it possible to control, tune and monitor them.

Connecting to 
the ATV 31

This table describes the procedure for connecting to the ATV 31.

Step Action

1 Connect your PC, on which PowerSuite for ATV 31 is installed, to the RJ45 
connector on the servodrive to be configured.

2 Start PowerSuite for ATV 31.
Result: the following start-up screen is displayed: 

3 Choose Action and then Connect.
Result: a text box is displayed.

4 Type a project name (ATV31_MFB) and then click on OK.
Result: a transfer confirmation window is displayed.

5 Press Alt F to start transferring data from the servodrive to the connected work 
station.

Powersuite
File Action Display Tools ?

My devices
i

en
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Basic ATV 31 
Configuration

This table describes the procedure for entering basic settings.

Step Action

1 Following a connection and transfer of the device’s configurations, PowerSuite displays a configuration 
screen in a new window that gives access to device control, tuning and monitoring functions.
Use the command Display → Configuration.
In the tree structure displayed, choose Communication in the Communication directory.
Result: the following window is displayed: 

2 In the ADCO line, the CANopen address must be set to 4.

3 In the BDCO line, the CANopen bus speed must be set to 500.

Motor control
      Motor 
characteristics
      Switching mode
      Speed scale
Terminal 
Configuration
      Inputs / Outputs
Control command
      Control 
command
Application 
functions
      Summing inputs
      Jog
      Ramps 
configuration
      Current 
limitation
      Preset speed 
choice

Powersuite - ATV31_MFB - Edit in connected mode

File Configuration Display Tools Scope ?

   Connected  en

Active

Inactive

Rotation

Forward

Reverse

  LSP                      
HSP
   0.0    0.0             

Status
Test run

Command Test stop Reset

   Stop
Device in fault

FLO     Forced local mode          Not assigned

ADCO Drive CANopen address  4

BDCO CANopen trans. speed     500 kbit/s

ERCO Error registry CANopen    0

CANopen
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4 Close the window to disconnect.
Note: it is possible to adjust the servodrive’s settings with the same procedure.
Result: the following screen is displayed, showing the data saved locally: 

Step Action

Powersuite

File Action Display Tools ?

My devices
      ATV31_MFB
            ATV31_MFB
            Serial point-
to-point
            Serial 
multidrop
My configurations
      Altivar drives
           ATV31
               ATV31_MFB

ATV31_MFB

Characteristics
DEVICE
Reference
Hardware type
Range
Nominal power
Supply voltage
Continuous output current
Max. transient current

ATV31 H037M2
Product on heatsink
Europe
0.37kW 0.5HP
220/240 single phase
3,3 A
5A

Structure
DEVICE
Serial number XXX43E009309
Version           V1.2|E03
Vendor name  TELEMECANIQUE

Control board
Serial number  Unknown
Version            V1.2|E03

HMI board
Version             V1.1|E02

Configurations

conf1 ATV31   ATV31_MFB   ATV31H037M2

Configuration

en
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Configuring the ATV 31 with the User Interface

Overview A user interface is integrated in the ATV 31. With this interface, you can:

put the device online
configure the device
carry out a diagnostic

Interface Menu 
Structure

The following graphic presents an overview of access to the interface’s main menus. 

Settings

Motor control

I/O

Control

Functions

Fault

Communication

Monitoring

ent

esc

ent

ent

esc

ent

ent

ent

ent

ent

ent

ent

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

esc

Menus

esc

Power-up

XXX Displays the drive status

Motor frequency (the factory setting is only
visible the first time the drice is powered up)
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Basic Settings The following table describes the procedure for entering basic settings (CANopen 
address and speed) with the interface.

Step Action

1 Press the ENT button on the interface.
Result: the SET (Setting) menu is displayed on the interface’s status indicator.

2 Press the  button several times to access the COM menu.
Result: the COM (Communication) menu is displayed on the interface’s status 
indicator.

3 Press the ENT button on the interface.
Result: the COAD (CANopen Address) submenu is displayed on the interface’s 
status indicator.

4 Press ENT again.
Result: a value corresponding to the device’s CANopen address is displayed.

5 Press the  button to decrease, or the  button to increase the CANopen address 
value.
Press ENT when the desired CANopen address is displayed (4).
Result: the value is confirmed and the COAD (CANopen Address) submenu is 
displayed again.

6 Press the  button to access the COBD (CANopen Baud) submenu.
Press ENT.
Result: a value corresponding to the device’s CANopen speed is displayed.

7 Press the  button to increase, or the  button to decrease the CANopen baud rate 
value.
Press ENT when the desired CANopen speed is displayed (500).
Result: the value is confirmed and the COBD (CANopen Baud) submenu is 
displayed again.

8 Press ESC several times to return to the main display (RDY by default).
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9.4 Tuning the ATV 31

Tuning the ATV 31 with PowerSuite

In Advance We recommend tuning the axis kinematic before the program automatically starts it.

Tuning Example The following table gives an example of kinematic tuning.

Step Action

1 Connect (see Connecting to the ATV 31, p. 131) to the ATV 31.

2 After a connection and transfer of the device’s configurations, PowerSuite opens a 
new window with the configuration screen, which gives access to device control, 
tuning and monitoring functions.
The following figure shows part of the new window. This lower window provides 
access to ATV 31 command functions: 

3 Place the Command zone cursor on Active.

4 Click the Reset button to clear any problems (if status is red).

5 Enter the value 1 in the Frequency reference zone.

6 Click the Test Run button.
Result: the motor runs and the sub-window is animated: 

7 Place the Command zone cursor on Inactive once tuning has been finalized.
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10

ATV 71 Implementation for Motion 
Function Blocks
At a Glance

Aim of this 
Chapter

This chapter presents the implementation of an ATV 71 servodrive according to the 
methodology (see Methodology, p. 17) described in the quick start guide (see Start-
up Guide for a Single Axis Application, p. 13) with a Lexium 05. It only details the 
differences and actions for an ATV 71.

What's in this 
Chapter?

This chapter contains the following sections:

Section Topic Page

10.1 Adapting the Application to the ATV 71 139

10.2 CANopen Bus Configuration ATV 71 143

10.3 Configuring the ATV 71 147

10.4 Tuning the ATV 71 154
137
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10.1 Adapting the Application to the ATV 71

At a Glance

Aim of this 
Section

This section presents adaptation of the application to the ATV 71 with an 
architecture, and hardware and software requirements.

What's in this 
Section?

This section contains the following topics:

Topic Page

Application Architecture with an ATV 71 140

Software Requirements 141

Hardware Requirements 142
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Application Architecture with an ATV 71

Overview The proposed architecture is simple and designed to assimilate the implementation 
principles of motion control.

Other equipment can be added to this realistic architecture in order to manage 
several axes.

Illustration The following figure shows the architecture used in the application that includes an 
ATV 71. 

Modicon M340

    ATV 71

Unity Pro

PowerSuite
for

ATV71 

CANopen

Junction box
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Software Requirements

Overview As regards the software requirements presented in the quick start guide (see Start-
up Guide for a Single Axis Application, p. 13), PowerSuite is used for configuring 
and tuning the ATV 71.

PowerSuite for Lexium 05 enables on-lining of the axis and guarantees a simple 
method for configuring the parameters of a Lexium 05 servodrive. PowerSuite for 
ATV 71 does the same, but for an ATV 71 servodrive.

It is nonetheless possible to go without PowerSuite in certain cases by using the 
ATV 71 front panel user interface (see Configuring the ATV 71 with the User 
Interface, p. 152).

Versions The following table lists the hardware and software versions used in the architecture 
(see Application Architecture with an ATV 71, p. 140), enabling the use of MFBs in 
Unity Pro.

Hardware Earliest version of software Earliest version of firmware

Modicon M340 Unity Pro V3.0 -

ATV 71 PowerSuite for ATV 71 V2.00 V1.1
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Hardware Requirements

References of 
the Hardware 
Used

The following table lists the hardware used in the architecture (see Application 
Architecture with an ATV 71, p. 140), enabling implementation of ATV 71 MFBs in 
Unity Pro.

Hardware Brand Reference

Modicon M340 PLC Telemecanique BMX P34 2030

Modicon M340 power supply Telemecanique BMX CPS 2000

Modicon M340 rack Telemecanique BMX XBP 0800

CANopen junction box 
between the  Modicon M340 
and ATV 71 servodrive

Telemecanique VW3CANTAP2

RJ45 programming cable with 
RS485/RS232 adapter 
between the junction box and 
servodrive

Telemecanique ACC2CRAAEF030

ATV 71 servodrive Telemecanique ATV71H075N2Z

Note: The terminating resistor is integrated in the junction box and must be  ON.
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10.2 CANopen Bus Configuration ATV 71

Configuration of the CANopen Slave (ATV 71) on CANopen bus

Overview The implementation methodology for a CANopen bus using Modicon M340 is to:

configure (see Configuration of the CANopen port, p. 31) the CANopen port of the 
CPU,
declarate the slave chosen from the hardware catalog (see paragraph bellow),
configure the slave,
enable the configuration using Unity Pro,
check (see Checking the CANopen Bus Configuration, p. 36) the CANopen bus 
in the Project browser.
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How to Configure 
the CANopen 
Slave

This table describes the procedure to configure the CANopen slave.

Step Action

1 In the Unity Pro Project Browser, fully expand the Configuration directory and then double-click on 
CANopen.
Result: The CANopen window appears. 

CANopen

Bus: CANopen comm head 01.003 Connections configured: 0
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2 Select Edit → New device.
Result: The New Device window appears. 

3 Set 5 in Topological Address.
For the slave device choose ATV71_V1_1.

Step Action

Part Number Description
CANopen drop

ATV31_V1_1
ATV31_V1_2
ATV31T_V1_3
ATV61_V1_1

New Device

OK

Cancel

HelpDiscrete
Motion

Topological Adress:        [1..63] 

Altivar 31 CANopen Slave DSP402 (TEATV3111E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV31T13E.eds)
ATV61 (TEATV6111E.eds)

ATV71_V1_1 ATV71 (TEATV7111E.eds)
IclA_IFA IclA-IFA CANopen (IclA-IFA.eds)
IclA_IFE IclA-IFE CANopen (IclA-IFE.eds)
IclA_IFS IclA-IFS CANopen (IclA-IFS.eds)

Lexium15LP_V1_4 EDS for Lexium 15LP servodrive (TELXM15LP_0142.eds) 
Lexium15MH_V6_61 EDS for Lexium 15MPHP servodrive (TELXM15MH_0661E.eds)
Osicoder Osicoder - absolute rotary multi-turn encoders (TEXCC3B_0100E.eds)

Altivar 31 CANopen Slave DSP402 (TEATV3112E.eds)

Node-ID:
3
3

IclA_N065 IclAN065 based on profiles DS301V4.01 and DSP402.V2.0 (BLIC....
Lexium05 DCX170 CANopen (TEDCX107_0100E.eds)
Lexium05_MFB LXM05A PLCopen (LEXIUM05_MFB.EDS)

Other

Drop end communicator
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4 Click on OK to confirm the choice.
Result: The CANopen window appears with the new device selected. 

5 Select Edit → Open module.
If MFB has not already been selected, choose it in the Function area.

6 You will be asked to validate your modifications when closing the Device and CANopen windows.

Step Action

CANopen

Bus: CANopen comm head 01.003 Connections configured: 1

5 0

...

ATV71_V1_1
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10.3 Configuring the ATV 71

At a Glance

Aim of this 
Section

This section describes the basic servodrive configurations using PowerSuite for 
ATV 71 and the servodrive’s front panel user interface.

What's in this 
Section?

This section contains the following topics:

Topic Page

Configuring the ATV 71 in PowerSuite 148

Configuring the ATV 71 with the User Interface 152
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Configuring the ATV 71 in PowerSuite

Overview With PowerSuite, users can define installed device bases, and describe their 
associated configurations and communication settings.

PowerSuite then gives access to a group of actions for editing or transferring the 
configurations and for connecting to the devices.

PowerSuite’s navigation principle associates a configuration interface with each 
device type, making it possible to control, tune and monitor them.
148 35013563 01 November 2007



ATV 71 for MFBs
Connecting to 
the ATV 71

This table describes the procedure for connecting to the ATV 71.

Step Action

1 Connect your PC, on which PowerSuite for ATV 71 is installed, to the RJ45 connector on the servodrive to 
be configured.

2 Start PowerSuite for ATV 71.
Result: the following start-up screen is displayed. 

3 Choose Action and then Connect.
Result: a text box is displayed.

4 Type a project name (ATV71_MFB) and then click on OK.
Result: a transfer confirmation window is displayed.

5 Press Alt F to start transferring data from the servodrive to the connected work station.

File Action Display Tools Help

Connections
My devices

PowerSuite

My devices

i

standard en
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Basic ATV 71 
Configuration

This table describes the procedure for entering basic settings.

Step Action

1 Following a connection and transfer of the device’s configurations, PowerSuite displays a configuration 
screen in a new window that gives access to device control, tuning and monitoring functions.
In the tree structure displayed, choose Communication in the Communication directory.
Result: the following window is displayed. 

2 In the ADCO line, the CANopen address must be set to 5.

3 In the BDCO line, the CANopen bus speed must be set to 500.
Note: It is possible to adjust the servodrive’s settings with the same procedure.

ATV71
   All parameters
      Access level
      Input summary
      Simply Start
         Settings
         Motor Control
         Inputs / Outputs configuration
         Command
         Applicative functions
         Fault management
         Communication
            Comm scanner configuration
            Modbus configuration
            CANopen configuration
            Forced local mode

File Parameters Command Display Configuration Tools ?
Find:

Standard profile en Connected

STOP
Switch on disabled

Command
Active
Inactive

Rotation
Forward
Reverse

LSP                 HSP
0.0          0      50.0

   Frequency reference

PowerSuite - Lexium05 - LEXIUM_MFB

! Code
Code
ADCO
BDCO

Short label
CANopen address
CANopen bit rate

Minimum value
OFF

Baud rate 50kbps

Maximum value
127

Baud rate 1Mbps

Current value
5

Baud rate 500kbps

Default 
OFF

125KB

State

PowerSuite - ATV71 - ATV71

Test run

Test run Reset
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4 Once the settings have been adjusted, use the command Configuration → Disconnect to disconnect.
Result: the following screen is displayed, showing the data saved locally. 

Step Action

PowerSuite
File Action Display Tools Help

i
My devices

ATV71
ATV71
Modbus network monodrop
Modbus keypad monodrop

Connections
Serial monodrop
Serial multidrop
Bluetooth
Ethernet bridge monodrop
Ethernet bridge multidrop
Ethernet TCP

ATV71

Characteristics

Reference

Nominal
Power

Supply Voltage

Maximum
transient
current 

Continuous

current

ATV71H075N4Z

0,75kW

380/480 V1~

3,5 A

2,3 A

Structure

Configuration(s)

Name

Software release

ATV71

V1.1|E01

Card

Device

Control
Board

Motor
Power part-

ATV71H075N4

Control part-
number

9217821317921431 V1.1|E01 Telemecanique

Telemecanique

Telemecanique

Reference
Serial
number Version Vendor name

output

number

V1.1|E01

V1.1|E01

02461310245256

2211280153

Standard  en 
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Configuring the ATV 71 with the User Interface

Overview A user interface is integrated in the ATV 71. With this interface, you can:

put the device online,
configure the device,
carry out a diagnostic.

Interface Menu 
Structure

The following graphic presents an overview of access to the interface’s main menus. 

Note: There is a more user-friendly graphic display terminal, for instance for 
diagnosing faults.

Communication

esc

ent

entesc

esc

esc

esc

esc

Power-up

XXX Displays the drive status
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Basic Settings The following table describes the procedure for entering basic settings (CANopen 
address and speed) with the interface.

Step Action

1 Press the ENT button on the interface.
Result: the SET (Setting) menu is displayed on the interface’s status indicator.

2
Press the  button several times to access the COM menu.

Result: the COM (Communication) menu is displayed on the interface’s status 
indicator.

3 Press the ENT button on the interface.
Result: the COAD (CANopen Address) submenu is displayed on the 
interface’s status indicator.

4 Press ENT again.
Result: a value corresponding to the device’s CANopen address is displayed.

5
Press the  button to decrease, or the  button to increase the 

CANopen address value.
Press ENT when the desired CANopen address is displayed (5).
Result: the value is confirmed and the COAD (CANopen Address) submenu 
is displayed again.

6
Press the  button to access the COBD (CANopen Baud) submenu.

Press ENT.
Result: a value corresponding to the device’s CANopen speed is displayed.

7
Press the  button to increase, or the  button to decrease the 

CANopen baud rate value.
Press ENT when the desired CANopen speed is displayed (500).
Result: the value is confirmed and the COBD (CANopen Baud) submenu is 
displayed again.

8 Press ESC several times to return to the main display (RDY by default).
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10.4 Tuning the ATV 71

Tuning the ATV 71 with PowerSuite

In Advance We recommend tuning the axis kinematic before the program automatically starts it.

Tuning Example The following table gives an example of kinematic tuning.

Step Action

1 Connect (see Connecting to the ATV 71, p. 149) to the ATV 71.

2 After a connection and transfer of the device’s configurations, PowerSuite opens a new window with the 
configuration screen, which gives access to device control, tuning and monitoring functions.
The following figure shows part of the new window. This lower window provides access to ATV 71 
command functions: 

3 Place the Command zone cursor on Active.

4 Click the Reset button to clear any problems.

5 Enter the value 10 in the Frequency reference zone.

6 Click the Test Run button.
Result: the motor runs and the sub-window is animated. 

7 Place the Command zone cursor on Inactive once tuning has been finalized.

Standard profile en Connected

Command
Active
Inactive

StateTest runTest run

Test runTest stop Test runReset

Rotation
Forward
Reverse

LSP                 HSP
0.0          0      50.0

   Frequency reference

Stop
Device in fault

[4]Rdy Switch On

Standard profile en Connected

RUN forward
Operation enabledCommand

Active
Inactive

Rotation
Forward
Reverse

POWER
ENABLE

LSP                 HSP
0.0         10      50.0

   Frequency reference

Test runTest run

Test runTest stop Test runReset
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IclA Implementation for Motion 
Function Blocks
At a Glance

Aim of this 
Chapter

This chapter presents the implementation of an IclA servodrive according to the 
methodology (see Methodology, p. 17) described in the quick start guide (see Start-
up Guide for a Single Axis Application, p. 13) with a Lexium 05. It only details the 
differences and actions for an IclA.

What's in this 
Chapter?

This chapter contains the following sections:

Section Topic Page

11.1 Adapting the Application to the IclA 156

11.2 CANopen Bus Configuration IclA 160

11.3 Configuring the IclA 161

11.4 Tuning the IclA 162
155



IclA for MFBs
11.1 Adapting the Application to the IclA

At a Glance

Aim of this 
Section

This section presents adaptation of the application to the IclA with an architecture, 
and hardware and software requirements.

What's in this 
Section?

This section contains the following topics:

Topic Page

Application Architecture with an IclA 157

Software Requirements 158

Hardware Requirements 159
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IclA for MFBs
Application Architecture with an IclA

Overview The proposed architecture is simple and designed to assimilate the implementation 
principles of motion control.

Other equipment can be added to this realistic architecture in order to manage 
several axes.

Illustration The following figure shows the architecture used in the application that includes an 
IclA IFS. 
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IclA for MFBs
Software Requirements

Overview As regards the software requirements presented in the quick start guide (see Start-
up Guide for a Single Axis Application, p. 13), IclA Easy  is used for configuring and 
tuning the IclA.

PowerSuite for Lexium 05 enables on-lining of the axis and guarantees a simple 
method for configuring the parameters of a Lexium 05 servodrive. IclA Easy does 
the same, but for an IclA servodrive.

It is nonetheless possible to go without Icla Easy for basic settings by using the IclA 
switches (see Configuring the IclA with DIP Switches, p. 161), since this is the only 
way to configure such settings.

Versions The following table lists the hardware and software versions used in the architecture 
(see Application Architecture with an IclA, p. 157), enabling the use of MFBs in 
Unity Pro.

Hardware Earliest version of software Earliest version of firmware

Modicon M340 Unity Pro V3.0 -

IclA EasyIclA V1.104 IclA IFA V1.105
IclA IFE V1.104
IclA IFS V1.107
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IclA for MFBs
Hardware Requirements

References of 
the Hardware 
Used

The following table lists the hardware used in the architecture (see Application 
Architecture with an IclA, p. 157), enabling implementation of IclA MFBs in 
Unity Pro.

Hardware Brand Reference

Modicon M340 PLC Telemecanique BMX P34 2030

Modicon M340 power 
supply

Telemecanique BMX CPS 2000

Modicon M340 rack Telemecanique BMX XBP 0800

CANopen SUB-D9-Way  
female connector (bended at 
90° + additional SUB-D9-
Way connector to connect a 
PC on the bus)

Telemecanique TSX CAN KCDF 90TP

CANopen preassembled 
cordset with moulded female 
SUB-D9-Way connectors at 
both end 

Telemecanique TSX CAN CADD03

Dongle PCAN PS/2 for IclA 
Easy (parallel-to-CAN 
converter) 

PEAK system IPEH-002019

CANopen cable Telemecanique TSX CAN CA50

IclA servodrive Berger Lahr IFS61/2-CAN-DS/-I-B54/0-001RPP41

Note: The terminating resistor is integrated in the IclA and must be ON (see 
Configuring the IclA with DIP Switches, p. 161).
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IclA for MFBs
11.2 CANopen Bus Configuration IclA

Configuration of the CANopen Slave (IclA) on CANopen bus

Overview The implementation methodology for a CANopen bus using Modicon M340 is to:

configure (see Configuration of the CANopen port, p. 31) the CANopen port of the 
CPU,
declarate the slave chosen from the hardware catalog (see paragraph bellow),
configure the slave,
enable the configuration using Unity Pro,
check (see Checking the CANopen Bus Configuration, p. 36) the CANopen bus 
in the Project browser.

How to Configure 
the CANopen 
Slave

This table describes the procedure to configure the CANopen slave.

Step Action

1 In the Unity Pro Project Browser, fully expand the Configuration directory and then 
double-click on CANopen.
Result: The CANopen window appears. 

2 Select Edit → New device.
Result: The New Device window appears: 

3 Set 6 in Topological Address.
For the slave device choose IclA_IFS.

4 Click on OK to confirm the choice.
Result: The CANopen window appears with the new device selected. 

5 Select Edit → Open module.
If MFB has not already been selected, choose it in the Function area.

6 You will be asked to validate your modifications when closing the Device and 
CANopen windows.
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IclA for MFBs
11.3 Configuring the IclA

Configuring the IclA with DIP Switches

Overview The address and baud rate are set with DIP switches on the IclA IFX drive.

DIP Switches The following graphic presents the DIP switches inside the drive: 

Basic Settings The baud rate is set with the S4 switch on position 5 for a baud rate of 500.

The CANopen address is set with the S1 and S2 switches. Set S2.3 and S2.2 ON 
for the drive to have address 6. By default, as shown in the graphic above, all the 
switches on S1 and S2 are set ON except the first switch on S1, which gives address 
127.

Set S3.2 ON to activate the terminating resistor.
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IclA for MFBs
11.4 Tuning the IclA

At a Glance

Aim of this 
Section

This section gives an example of tuning the IclA with IclA Easy.

What's in this 
Section?

This section contains the following topics:

Topic Page

Configuring the IclA in IclA Easy 163

Tuning the IclA with IclA Easy 165
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IclA for MFBs
Configuring the IclA in IclA Easy

Overview With IclA Easy, users can define installed device bases, and describe their 
associated configurations and communication settings.

IclA Easy then gives access to a group of actions for editing or transferring the 
configurations and for connecting to the devices.

IclA Easy’s navigation principle associates a configuration interface with each 
device type, making it possible to control, tune and monitor them.

Connecting to 
the IclA

This table describes the procedure for connecting to the IclA.

Note: The required signals, i.e LIMN, LIMP, REF must be wired or deactived by  
the tuning software.

Step Action

1 Connect your PC, on which IclA Easy is installed, to the Dongle PCAN PS/2 connector 
on the servodrive to be configured.

2 Start PowerSuite for IclA.
Result: The following start-up screen is displayed: 

3 Choose the command Connection → CAN Connection.
Result: a text box is displayed. 

4 The Baudrate must be set to 500 Kbaud.
The CAN address must be set to 6.
The Hardware must be set to LPT1 (Dongle PCAN PS/2).
Result: A data transfer from the servodrive to the connected work station is begun.
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IclA for MFBs
Basic IclA 
Configuration

An example is given to illustrate modification of the  acceleration value. This table 
describes the procedure for entering this setting:

Step Action

1 Following a connection and transfer of the device’s configurations, IclA Easy displays 
a screen that gives access to device control, tuning and monitoring functions.

2 Choose the Motion parameter in the Parameter Groups.
Result: The Parameter window is displayed. 

3 In the acc line, the acceleration can be set to 1000.

4 Save the CANopen settings to EEprom with the command Parameter → Send 
parameter group to  drive.
Note: It is possible to adjust the servodrive’s settings with the same procedure.

5 Once the settings have been adjusted, use the command File → Close to disconnect.
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IclA for MFBs
Tuning the IclA with IclA Easy

In Advance We recommend tuning the axis kinematic before the program automatically starts it.

Tuning Example The following table gives an example of kinematic tuning.

Step Action

1 Connect (see Connecting to the IclA, p. 163) to the IclA.

2 The following figure shows part of the new window. This lower window provides 
access to IclA command functions: 

3 Click the Reset button to clear any problems.

4 Place the Enable zone cursor on ON.

5 Choose the command Functions → Operating modes.
Result: Operating modes windows is displayed.

6 Choose the Speed mode tab
Enter the value 200 in the Setpoint value zone.
Result: The motor runs and the sub-window is animated: 

7 Place the Enable zone cursor on OFF once tuning has been finalized.
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